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About This Guide

The Advanced Feature Reference is a comprehensive reference for the following
FIREHOUSE Software advanced features:

• Import External Data, Chapter 2
• System Rules and Default Values, Chapter 3
• Setup Automated Tasks, Chapter 4
• Station Management, Chapter 5
• User Fields, Chapter 6
• Creating Queries, Chapter 7
• Creating and Modifying Reports, Chapter 8
• Report Designer Layout, Chapter 9
• Auto-Generated Narratives, Chapter 10
• Signature Capture, Chapter 11
• Creating and Modifying Graphs, Chapter 12
• User-Defined Fields in Transaction Files, Appendix A

Additional information is available while running FH by pressing F1.
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Who Should Use This Reference?

Procedures in this manual assume FIREHOUSE Software is already
running, that you have a basic understanding of how to navigate in
Windows programs (for example, you are familiar with how to use a
mouse to select a menu), and are familiar with the basic purpose of
each module installed.

If FIREHOUSE Software has not been installed, follow the installation
instructions included with the installation CDs.

If you are not familiar with FIREHOUSE Software, you should
familiarize yourself with the basic functions of the software detailed in
the Tutorial section of the User Guide. When you encounter an
unfamiliar form press F1 to display specific information about the
form. Access to related information can be displayed by pressing Click
for related topics....

Advisories
There are three levels of advisories present. Each level is indicated
with a symbol:

Notice advisories contain general information that may
save time and effort within FH.

Caution advisories contain information that can help you
avoid minor inconveniences.

Danger advisories contain crucial information for avoiding
loss of information.

More Information
If there are any questions this manual does not answer, check the FH 7
help file provided with all versions of this program. To access the help
file from FH, press F1 or select an option from the Help menu.
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Use The Help File For Procedures

The help file is context sensitive. When you are using specific areas in
FIREHOUSE Software, press F1 and information about the area is
displayed. The help file can also be run separately from within FH by
selecting the Help menu FIREHOUSE Software Help File option.

With the help file displayed, you can use the FH 7 Help File Contents to
locate specific information, or go to Search, type in the keywords to
search for, then press List Topics. Select a topic then press Display.

More help on using the help file is available from the Tips for Using
This File link at the bottom of the help file home page.
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Import External Data Source

Much of the information that needs to be entered into FIREHOUSE Software may
already be available. Rather than reentering the data into FIREHOUSE Software
manually, you can import data from other programs as long as the data is in or can
be converted to a format accepted by FH.

Acceptable data sources are listed on page 7.

The process for importing external data into FH is straightforward:

• Prepare data source. See page 6 for details.
• Access external data source definitions area. See page 9 for details.
• Add new definition. See page 9 for details.
• Preview Import (optional). See page 19 for details.
• Run External Data Source Definition. See page 19 for details.

Chapter 2
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Prepare Data Source

Familiarity with FH and planning prior to importing external data will
help assure that the data is properly imported. Before starting the
import process, consider the following:

• Identify import data elements. Decide what data elements from the
source should be imported into FH.

• Complete master records, if necessary. Ensure that master records
are available if the source includes child records.

Master Records are described on page 7.
• Save data source to an acceptable format if it is not already in an

acceptable format.
Acceptable formats are listed on page 7.

Identify Import Data Elements
To be able to use the source data, you should determine if FH tracks
the information and where. Run reports to determine the FH data
structure to determine where the source information should be
directed.

For a complete listing of FH data tables:

• From the Reports menu, select the Administrative Reports
option. The Reports listing is displayed.

• Select the Database Structure Report.
• Press Run. The Output Report To form is displayed.
• Select an output option then press OK. The Query Parameters form

is displayed.
• Press OK. A complete listing of FH data tables is directed to the

specified output.

At a minimum, your import must create values in the required fields to
create a record in that area. For example, to create a valid staff record,
you must import or create a Staff ID (STF_MAIN.DBF, Staff ID field),
and a First, and Last name (STF_MAIN.DBF, FIRST field and LAST
field).

If you do not know which fields are required, run the import definition,
then press View Import External Data History Log... after the import
results are displayed. If records are skipped because of missing fields,
the missing fields are referenced. Also determine required fields from
the main data entry form for the record  — by default empty required
fields are yellow and completed required fields are blue.
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Contact area agencies and find out what information they have
available. Consider the following possibilities:

• Streets: Your city or county government may have a list of streets
for your coverage area.

• Occupancy Records: Your city or county government may have
records about properties that you can import into the Occupancy
Management module.

• Hydrants: Your local water works department may have hydrant
information.

Interfaces to a number of CAD systems are available. Contact your sales
representative for more information.

Master Records
Master records contain primary information of a specific type (for
example, staff information). Related child records include additional
details about master records when additional detail is available,
eliminating the need for empty data elements in the master record.
Master and child records are related together using an ID. The ID field
is a unique value that identifies a specific unique record, and when
used in a child record, associates the child record with a specific
master record.

When importing external data that goes to target FH child records, a
corresponding master record must be available. For example, staff
records need to be added to FH before you can import staff activities
for that staff member. When you import a child record that relates to a
master record, you must use the exact ID FH uses to identify the
master record. Generally you will be importing external data into
master records.

Save Data Source to Acceptable Format
FH can import the following data formats directly:

Acceptable Source
Formats

Description of the Source File Format

Comma-Delimited
.csv file

Fields are separated by a comma (“,”). Most spreadsheets and databases
can generate this format.

Tab-Delimited
.txt file

Fields are separated by a tab. Most spreadsheets and databases can
generate this format.

Space-Delimited
.prn file

Fields occupy defined positions in the source file. Some spreadsheets and
databases can generate this format.

.DBF Table Fields are stored in a standard database format. An advantage to this
format is that fields in the source will be identified by a field name.
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ODBC Data Source ODBC is an abbreviation for Open DataBase Connectivity, ODBC makes it
possible for FH to access any ODBC-compliant data. The ODBC source is

set up outside of FH before FH can use the source.

If your data source is not in one of the accepted formats, try exporting
the data into an accepted format. If the external data source cannot
export to an acceptable format, try a third-party program (for example,
spreadsheet programs can often open a variety of data types and are
generally capable of saving to a format accepted for FH import) to open
the external file, then save it to an accepted format.

Import External Data Source8



Create an Import Definition

An import definition is a set of instructions that include a path to an
external data source and directions for where external source data
elements should go in FH target tables. You create the import definition
using FH.

Accessing External Data Imports
You can create as many external data imports as needed.

Import definitions can be shared between separate
departments using Copy to/Install from feature. This
feature is described in the help file “Copy and Install
Components” topic.

To Add an External Data Definition
� From the Administration menu, select the Database

Administration option, Import From External Data Source…
option. The External Data Imports form is displayed.
The External Data
Imports form Import
section lists all import
definitions added to the
system.

See page 19 for the steps to preview
an import. See page 19 for the steps
to run an import definition.

With the External Data
Imports form displayed,
press New. The Select
Import Type dialog is
displayed.

1. Select either Standard Database Import
or Lookup Table Import…
� Choose Lookup Table Import if the

source file only includes data to import
into a single category in a specific
lookup table (for example, the “Streets”
category in General System Codes).
� Select Lookup Table. The Category field is required.

9Create an Import Definition

Installable
Component



� Press and highlight a lookup table and category, then
press Select. The selected lookup category is added to the
field. The rest of the process for completing the import
definition is the same as for a standard import, except target
fields are all automatically added for the lookup.

� Choose Standard Database Import for source files that include
non-lookup table data or lookup table data for multiple
categories.

2. Press OK. The External Data Import Definition form is displayed.

3. Type the name of the
import in Import Name
and select the external
data source.

Select a
name for
the import
definition
that briefly
describes
the type of
data included in the import.

4. Specify the type of source data in Source Types. Available types:
• Comma-Delimited
• Tab-Delimited
• Space-Delimited
• DBF Table
• ODBC Data Source

Select ODBC only if an ODBC source has been set up on
your workstation. ODBC set up is completed outside of
FH. FH cannot provide assistance in setting up ODBC
sources for external data sources as part of its regular
support services.

More information on acceptable data source formats is listed on page 7.

5. Select the source file:
� Press and locate the source file, then press Open. The path

to the source file is inserted into the Source File Name field.

� Press ODBC Setup... (only enabled when the selected source
format is ODBC) to access and select the ODBC source.

All data elements added to the import definition are added to the
area.

The steps to add fields to the import definition are detailed on page 11. Setting rules
for the import definition is described on page 15.

Import External Data Source10
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To Add a Field to a Definition

With the External Data Import Properties form displayed, press Add
to specify the target field
where a specific external data
element will be sent. The
External Data Import Field
Properties form is displayed.

The form to the right is displayed for
DBF source files. Sample data for
ASCII tab- and comma-delimited files
are displayed on the same form but
field names are not listed. Space
delimited files use a different form,
requiring that the start position and
length for each field be specified.
� Select the FH table where

the source data will be imported in Target Table.
A complete list of FH target tables and fields is available. See page 6 for instructions.
� Select a field in the target table where a specific source field will be

imported in Target Field. All available fields in the source file are
listed in the area with sample data from the first
record. Note that the way the fields are named depends on the
source type:
� Comma-Delimited. Source fields are listed by number, starting

at “1”. In the source file, fields are separated by commas. A
paragraph return marks the next record.

� Tab-Delimited. Source fields are listed by number, starting at
“1”. Fields are separated by tabs. A paragraph return marks the
next record.

� Space-Delimited. Source fields are located by their starting
position and length.

� DBF. Source fields are identified by field name.
� ODBC. How fields are listed varies based on the ODBC source.

� Highlight the source field you want to direct into the selected target
field. Setting rules for importing the field are detailed next.

� You can optionally specify additional rules for how the current field
are imported:
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To accept default rules for this field
without making any changes, skip to
“Finish Adding Field To Import” on
page 14.

� To automatically
replace a target field
value with a literal
value or expression:
� Click Replace field

with literal value or
expression. The
Replace field with
literal value or
expression form is
displayed.

� Enter a literal value
or expression.
The value entered
here replaces any
value in the source
field. Note that the
value specified needs to match the format of the FH target
field. For example, if the target field is numeric, the
replacement value needs to be numeric.

If you were importing staff member records and wanted
the staff member’s station to always be “2” even though
the source staff member records may include values other
than “2”, you would type “2” (no quotation marks needed).
The expression entered varies depending on the type of
source file:
Comma-Delimited. Expressions refer to source fields as
DATA(x) where x is the source field column.
Tab-Delimited. Expressions refer to source fields as
DATA(x)where x is the source field column.
Space-Delimited. Expressions refer to source fields as
Substr(cRecord,x,y)where x is the start position
for the source field and y is the number of positions
allocated for the source field.
DBF. Expressions refer to source fields as
source.field_name where source is the temporary
name assigned for the source database and Field_name
is the name of the field from source table.
ODBC. Expressions refer to source fields as
odbc.field_name where odbc is the temporary name
assigned for the source database and Field_name is the
name of the field from source table.

� Press OK to make the literal value or expression replace the
source values when the import is run.

Import External Data Source12
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� Click Replace field with literal value or expression again to
disable replacement (entered values are saved and available
by enabling the option again).

� To choose a single word from a source field that includes
multiple words to fill the target field:
� Check Replace field with a single extracted word... The

Replace field with a single extracted word... form is
displayed.

� Enter the word number and the
character that always separates
words in the source field.

To select a street name in
a source file that lists
county, street name, and city in a single field with each
word separated by a space, enter “2” in Word Number, and
type a space in Delimiter. Only the second word in the
source field would be imported to the FH target field.

� Press OK to import the specified word from the source field
when the import is run.

� Click Replace field with a single extracted word... again to
disable replacement (entered values are saved and available
by checking the box again).

� To change source data format to match target table format (not
checked by default):
� Check Apply input mask (format) to source... The Apply

input mask (format) to source data... form is displayed.
� Type an input mask

in Enter input mask.
When you type 9 the
alphanumeric
character from the
corresponding
position of the data source field is imported. For example,
999 would import the first three characters from the data
source field.

� Press OK to apply the input mask to the source file.
� To convert source data to all upper case, check Convert source

data to upper case to convert source data field value to upper
case as they are imported into the specified target field.

� To capitalize the first letter in the first word (remaining letters
lower cased), check Convert Source data to proper case.

When both Convert source data to upper case and Convert
source data to proper case are checked, proper case is
applied.

13Create an Import Definition
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� To right align data to the right side of the target field (filled to
the left with spaces), check Right-Align data.

� To only import a source record if a specified value is unique:
� Click Add Record to target table only if unique... The Add

record to target table only if unique... form is displayed.
� Type the name of

the target field used
to qualify whether
the record is unique.

Only records that
contain a unique
value in the source field are imported to the specified target
field. For example, if the source field has a value repeated
only the first record is imported; subsequent records with the
repeated value are skipped.

You can add another field to your definition or save the current field
properties and return to the import properties if all fields have been
added.

� To save field and add another:
� Press CTRL + Y, or position cursor over Save button, right click

then select Save + New. The Extended Data Import Field
Properties form is displayed.

� To save field and return to import definition:
� Press Ctrl + W, or position cursor over Save button, right click

then select Save + Close. The External Data Import Field
Properties form is closed and the External Data Input
Properties form is displayed.
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Specifying Import Definition Rules
After all the fields have been added to the import definition, you are
ready to define rules for the import definition.

To Add Import Definition Rules

With the External Data Import Definition form displayed, click the
Rules tab. The Rules section includes options specifying how the
imported data is treated.

� To overwrite existing FH
records with duplicate
import records, leave
Don’t Overwrite existing
records in target fields
unchecked. If source and
target records have
identical ID field values,
the FH target records are
replaced by the source
values.

If you do not want to
overwrite existing FH records,
you can merge source record with target record when the source and
target record IDs match, or skip source records entirely when the
record ID exists in the target record.

� To merge or skip source records:
� Check Don’t overwrite existing records in target tables.
� Select how records will

be skipped:
� To merge source field

values into target fields
when the values are
different, check Don’t overwrite, but merge source data into
existing records.

Note that if you opt to merge source data into existing
records, all values selected in the source are imported and
replace existing target values.

� To skip the source record when the source and target records have
duplicate ID values, leave Don’t overwrite, but merge source data
into existing records unchecked.

� Press OK.

15Create an Import Definition
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� Check Update Lookup Tables with new values as needed to
automatically create entries in the appropriate lookup table when
source data is imported into lookup driven target fields. The values
in the source fields are used to create a list of codes for the lookup
tables. You will need to add a description for each lookup code
created after the import is run.

A record ID must be unique for master records; you can
not import records with duplicate IDs. A master record ID
(also known as a key field) is a field that contains a unique
value that identifies the master record. Generally, ID fields
in FH include “ID” in the field name (for example,
STAFF_ID).

� To automatically generate a master record ID in the FH target table
if an ID is not available in the source, check Generate master record
ID numbers as needed.
Leave this option enabled if you are importing new records into FH
unless you have a specific reason for importing IDs from source to
target. If you are merging source records into existing FH records,
this option should be disabled. When merging, extra care needs to
be taken to assure that the ID from the source is identical to the
target ID.

See page 15 for more information on selecting the merge option.

Do not check the following option unless you want to
completely erase FH target tables included in the import
definition. Never create an import with this option unless
you have a current backup of your FH data. The only way
to recover deleted data is to restore your backup
(assuming you have a current backup).

� Check Erase data in target tables before import to completely delete
all records in the FH target table before performing the import.

Do not check the following option unless you want to
completely erase the source file referenced in the import
definition. Never create an import with this option unless
you have a method of restoring the source file.

� Check Delete source records after import to delete the source
records after the import is run. Typically used when an external
program generates the source periodically. For example, a computer
aided dispatch system that outputs a daily file that includes
incidents.

Import External Data Source16
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� Check Skip source records when… and enter an expression that,
when true, skips a source record. The Skip Source records when…
form is displayed.
� Type the source field

name to evaluate. For
ASCII tab- and
comma-delimited
source files, fields are
referenced as DATA(n)
where n is the number assigned to the source field. Use the field
name for DBF source files.

See page 11 for information about how source data fields are named.
� Type the qualifier used to determine whether the source record

should be skipped (that is, not imported).
Acceptable qualifiers are:
= equal
== exactly equal
$ Contains
> Greater than
< Less than

� Type the value used to determine if the record is skipped.
Enclose the value in quotations. For example the expression
data(9) = ‘16001’ (where data (9) is the ninth field in an
ASCII tab or comma delimited file), all source records that
contain the value 16001 will NOT be imported into the specified
target records.

� Press OK.
� Check Apply default values to unassigned fields to automatically fill

in target fields that are not populated with values from the source
data using default values that have been specified via System Rules
and Values.

System Rules and Default Values are detailed starting page 23.

For example, if you have defined a default county to insert
into new occupancy records, check Apply default values to
unassigned fields to insert the default value in records
created during the import process. Note that if the County
field is included in the import, the source value for the
county will be used.

� Check Backup target tables before data is committed to create a
copy of the target tables before the source records alter the target
tables.

When a backup is created prior to running the import, a
copy of the target table is placed in the active database
directory.
*.BAK is a copy of the DBF file
*.TBK is a copy of the FPT file.
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� Save and close import definition.

To View Import Definition Log
With the External Data Imports form displayed and a specific import
definition from the list highlighted, press the Log tab. The Log section
is displayed.

� Highlight a specific date
and external import then
press Details... to view
information about the
external import.

� Highlight a specific date
and external import then
press Delete to remove the
external import log.

Each time
an import
definition is
run, details about the import are appended to the end of
the import log. The import log will eventually become very
long.

� Press Purge and select Yes when prompted to delete all log records.

Import External Data Source18
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Using Import Definitions

Now that you have taken the time and effort to create an import
definition, you are ready to use it. You can preview the results of your
import definition without importing any records.

Previewing Import Definition
View the results of a specified number of records from an import
without physically importing the source data.

Using preview can minimize the time to test a new import
definition when the source file contains a large volume of
records since you can specify a limited number of records
to include in the preview.

To Preview an Import Definition

With the External Imports form displayed:

Accessing the External Data Imports form is described on page 9.
� Highlight the external import to preview, then press Preview. You

are prompted to select the number of records to preview.
� Specify the number of

records from the source
file indicated in the import
definition you wish to
preview in Preview, or
leave “0” to preview all
records in the source file.

� Press OK to review the results of the import definition.
� Press Cancel to cancel without previewing the import definition.

Running an Import Definition
When you run the import definition, you can view the import and
commit if the results look valid.

To Run an Import Definition

With the External Data Imports form displayed:
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Accessing the External Data Exports form is described on page 9.
� Highlight the import you wish to run, then press Run.
� Press Yes when prompted to run the import. A progress bar is

displayed.
When the import is complete, the External Data Import
Pre-Commit Results form is displayed.

� Press Show Import Results
for Table to view results
for FH target tables. Even
when importing into a
single target table, there
may be multiple target
tables if you opted to
automatically update
lookups.

� Review vital information
detailing the import:
• Records Accepted

displays the number of records processed without errors are
listed.

• Records Rejected displays the number of records that were
rejected are listed. Records are rejected for a variety of reasons.

• Source Records Skipped displays the number of records that
were skipped.

� Remove invalid records from external import:
� Highlight the record in the Records area, then press Remove.

� Change lookup code descriptions if necessary:
� Select the lookup table in Show Import Results for Table.
� Press Change Code Description…
� Change the code description.
� Press OK.
� Repeat for each code you wish to add descriptions for.

� View import errors and exceptions:
� Press the Errors & Exceptions tab to view details about records

excluded from the import. The View Errors & Exceptions section
is displayed.

� Press Commit to add import results to your FH database.
� Press Cancel to exit the import without committing import results

into the target tables.
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Sample Import

Before running an experimental
import, you should change to the
DemoData directory. To change to the
DemoData directory with FH running
(if DemoData is not already selected),
access the File menu Logout option,
and in the Login form change the
Database field to point to the
DemoData database.

Import Sample Lookup Data Source
� From the Administration menu,

select Database Administration
option, then the Import from
External Data Source option.

� Press New to define the sample
import.

� Choose Lookup Table Import. The Category field is required.
� Press next to Categories. The Lookup Tables form is displayed.
� Select System Wide Codes, drill down to select the Streets codes

category, then select Street Names.
� Press Select. The Select Import Type form is displayed with the

category name filled in (“ST NAME”)
� Press OK. The External Data Import Definition form is displayed

with the import name already completed.
� Press next to the Source File Name to display a file location

dialog. Find and select the source file.
� In the Fields section, press Add. The External Data Import Field

Properties form is displayed with sample data from the first source
record.
The following steps assume that you have created the sample file
detailed at the start of this example.

� Select PREFIX for the Target Field, then highlight field 1. Position
the cursor over the Save button, then right-click and select Save &
New (or press Ctrl+Y).

� Select STREET for the Target Field, then highlight field 2.
For consistency, you want to ensure that all street names look the
same. In the sample file you created, the second record lists the
street name in lower-case (all the others are proper case). The next
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Create Your Own
Simple Data Source
For the purpose of learning, you can create
a list of streets using a text editor. Open the

text editor, type "E", press Tab on the

keyboard, type "Barney", press Tab again,

type "ST", then press Enter on the

keyboard. Using the same steps, create

several more streets.
When you're finished, the text file should
look something like this:
E Barney
ST
W barney
ST
N Broad
AVE
S Broad
AVE

Center
ST
Save the file, naming it STREET.TXT and
note the location you save it to (for
example, A:).



step will make all street names have the same proper case (that is,
first letter capitalized).

� Click the Rules tab, then check Convert source data to proper case.
� Position the cursor over the Save button, then right-click and select

Save & New (or press Ctrl+Y).
� Select TYPE for the Target Field, then highlight field 3. Position the

cursor over the Save button, then right-click and select Save &
Close (or press Ctrl+W). The External Data Import Properties
form is displayed, and the fields you have selected to import are
listed.

� Right-click while your mouse is over the Save button and select
Save & Close (or press Ctrl+W). The External Data Imports form
is displayed, and Street Names is listed as an external data import.

� Highlight Street Names, then press Preview. The External Data
Import Pre-Commit Results form is displayed.

If this was a list of streets you wanted to import and everything looked
OK, you would be ready to run the import and commit the data.
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System Rules and Default Values

This powerful feature should be used only after careful consideration.
Adding field requirements and validation rules can complicate data entry
for your users since more information must be entered to complete a
record and the information entered must satisfy more requirements.
System Rules and Default Values allow the FH Administrator to create
rules for record entry and default values automatically included in specific
fields for new records. Rules specify whether fields are required to
complete the record, define specific record completion requirements, and
set required criteria for field values.

Chapter 3
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About Field-Level Rules and Default Values

You can add rules for all non-system fields. Rules are divided into the
following types:

• Default Value. You may have fields that will always have a
specific value. In those cases, you can specify a value to default
in the field so when a new record is created, the default value is
inserted. See page 25 for more information.

• Require Field. You can specify that data in a certain field is
required when a record is entered in the data entry form. When
a field is required but not complete, the field is listed as required
in the validation results when you attempt to save the record.
See page 26 for more information.

• Disable Field. Specify that the field is explicitly not available or
unavailable based on conditional criteria. See page 26 for more
information.

• Error Condition. Validation rules allow specific criteria to be
defined in order for the field to be valid. If the field value is not
valid under the rules you define, the field is tagged as invalid.
See page 27 for more information.

• Update the Value of Another Field. You can update the value of
any field in the current user selected table with a value or
expression you specify.

Some fields are locked because they are part of system validations. You
can add multiple rules of different types to a single field. You cannot
modify certain properties of system fields.

System Rules and Default Values can be shared between
separate departments using Copy to/Install from feature.
This feature is described in the help file “Copy and Install
Components” topic.

You can add record-level rules to require that a record in a related
child table be present. See page 28 for more information.

Adding System Rules and Default Values
All system rules and default values are added from the System Rules
and Default Values form.
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To Add Field Level Rules
� From the Administration menu, select the System Rules and

Default Values option. The System Rules and Default Values
form is displayed.
The System Rules and Default Values form lists all available
record areas. There are
specific tables associated
with each record area.
When data is entered in a
form, the records are
written to a specific table.

� Choose a specific record
area by pressing .
Tables associated with the
record area are listed.

� Select the table that you
wish to specify rules and
default values for. For example, if you want to modify the rules and
validations for new Occupancy records, select the Occupancy
Management record area then OCC_MAIN (Occupancy Master
Records).

� Press Setup... The System
Rules and Default Values
form for the table is
displayed.

� Highlight a field listed in
the System Rules and
Default Values form, then
press Add. The Select
Rule Type form is
displayed.

� To add a default value to a
rule:

Beware of adding too many defaults, since defaulted values
are seldom modified once the record is complete.

� Select Default Value then press OK. The Default Value form is
displayed.

� Type the default value
for the field, or press

.
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� If the highlighted field is linked to a lookup category, you are
prompted to select a default value from the list. Press Yes to
select a default value from the list of available lookup codes,
select the code for the default value, then press OK. The
selected value is inserted into the field.

� If the highlighted field is not linked to a lookup category, or if
you press No when prompted, the System Rule Expression
form is displayed. Note that the value you enter is an
expression and must follow all syntax required for
expressions. Do not attempt to format the expression (that is,
do not press Enter) since formatting will invalidate your
expression.

Steps for using the System Rule Expression form are listed on page 127.
� Press OK. See page 27 for the steps to save the rules added for

the table.
� To require a field:

� Select Require Field then press OK. The Require Field form is
displayed.

� Check Require field always to require a value in this field for the
record to be complete. When Require field always is not
checked, the Require field when the following.... field is
available.

� Enter the criteria in the Require field when the following.... that
determines whether this field is required (for example, if another
field in the record is a certain value):
� Press . The System Rule Expression form is displayed.
� Specify the condition to be satisfied for the field to be

required. It is possible for the same field to have a default
value and requirement condition.

Steps for using the System Rule Expression form are listed on page 127.
� Press OK to save.

We recommend restraint in this area. Each additional
requirement adds an additional field that must be entered
before the record is complete.

� To disable a field:
� Select Disable Field then press OK. The Disable Field form is

displayed.
� Check Disable field always to prevent values from ever being

entered into field. If not checked, you can specify conditions for
when the field is disabled (for example, when another field in
the record contains a certain value).

� Enter the criteria in the Disable field when the following
expression evaluates to true that determines whether this field is
disabled (for example, if another field in the record is a certain
value):
� Press . The System Rule Expression form is displayed.
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� Specify the condition to be satisfied for the field to be
disabled.

Steps for using the System Rule Expression form are listed on page 127.
� Press OK.

� To add an error condition:
� Select Error Condition then press OK. The Error Condition form

is displayed.
� Type a valid expression that specifies the condition for the field's

validity. Press to display the System Rule Expression form.
Steps for using the System Rule Expression form are listed on page 127.

� Type an error message to display when the validation condition
specified above is true in Specify a Custom Validation Message…
Be sure to be as detailed as possible since this message should
help the user correct the field. You can include valid expressions
inside a text message if necessary.

� Select Severity level, Critical, Warning, or Info only.
� Press OK. See page 27 for the steps to save the rules added for

the table.
� To update the value of another field:

� Select Update the Value of Another Field.
� Press OK.
� Select a field in the current table to replace.
� Type a valid expression or value in Replace Field Value If that

specifies the condition for replacing the specified field, or press
to display the System Rule Expression form.

Steps for using the System Rule Expression form are listed on page 127.
� Type a value or expression in Value/Expression To Use as

Replacement to use to replace the specified field, or press to
display the System Rule Expression form.

� Press OK.
� Press OK to save.
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About Record-Level Rules

You can require that a record in a related child table be present. For
example, you can specify that the occupancy preplan record (a child
record of the main occupancy record) be completed for all occupancy
records.

To Add a Record-Level Rule
� Access the System Rules and Default Values form for the main

occupancy table (steps detailed page 24).
� Click the Record-Level Rules tab to display the Record-Level Rules

section.
� Press Add to require a child record be completed.
� Select the child record in

the Require a record in the
following child table field.
Check Require a record
always to always required
this child record. When
Require a record always is
not checked, add an
expression in Require a
record when the following expression evaluates to true by typing
the expression or pressing to display the System Rule
Expression builder.

� Press OK.

System Rules and Default Values28



Remove All User-Defined Rules for Current Table

If you encounter problems as a result of the field or record properties
specified for the table, you can either correct the problems individually,
remove all user-defined rules for the table, or remove all user-defined
rules from FH and start over. To correct problems individually, access
the rule properties and edit.

Remove User-Defined Rules from Selected Table
To remove all user-defined rules for a table:

� From the Administration menu, select the System Rules and
Default Values option. The System Rules and Default Values
form is displayed.

� Choose a specific record area by pressing . Tables associated
with the record area are listed.

� Highlight the table name that you want to remove user-defined
rules from.

� Press Setup…
� Press Reset. You are prompted that rules will be removed from the

selected table.
� Select Yes.

All user-defined field properties for the selected table are removed.

Remove All User-Defined Rules from FH
As a last resort, you can remove all user-defined rules from FH:

� From the Administration menu, select the System Rules and
Default Values option. The System Rules and Default Values
form is displayed.

� Press Options... A menu of choices is displayed.
� Select Remove All User-Defined Rules. You are prompted with the

number of rules to be removed and whether to proceed.
� Select Yes.

All user-defined field properties are removed from FH.
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Setup Automated Tasks

Automated tasks can be set up to automatically perform various functions at
user-defined intervals.

Automated tasks added to FH are evaluated by the automated task processor. The
automated task processor reviews each automated task and determines if it is time
to run the task. You enable the automated task processor from the Tools menu,
Workstation Options... option. Access the Other... section of the Workstation
Options form and specify the automated task processor status in the Automated
Tasks area.

The remainder of this chapter details how to add automated tasks.
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Adding Automated Tasks

Before adding automated tasks, consider timing and licensing.

• Task Timing. Make sure timing is appropriate. If you do not allow
sufficient time for one station to complete an export before the
target station begins importing, the import process will not be
successful. This is especially important for automated tasks that
run unattended.

• Task Licensing. The automated task processor is considered to be a
user by FH when it scans for the number of active users and
available licenses when a user logs in. Each concurrent user
requires a license. If you run automated tasks 24 hours a day, an
additional license for the workstation running the task at the
central station is recommended.

Valid task types are listed below:

• Export to Station, detailed page 33.
• Import from Station, detailed page 34.
• Import External Data, detailed page 34.
• Run Database Tools, detailed page 35.
• Backup Database, detailed page 36.
• Run External Application, detailed page 37.
• Run Add-On, detailed page 38.
• Print a Report, detailed page 39.
• Run a Query, detailed page 40.
• NFIRS Transaction File Import, detailed page 41.
• EMS Transaction File Import, detailed page 42.
• Update Scheduling Activity, detailed page 43.

Export to Station Task
Use Export to Station task for outlying stations that are not connected
to the central station with a high speed connection. The outlying
station can be set to automatically export data at regularly scheduled
intervals. As long as you are not deleting files during the export and the
automated task specifies overlapping date ranges when exporting (the
resulting duplicate records are skipped during the import), there is no
opportunity for data loss should an import be interrupted or skipped.
The central station needs to add a corresponding Import from Station
task to import the outlying station's exported data.
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To Set Export to Station Task Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Export to Station.
� Press Setup Task Parameters... the Export Data to Station form

is displayed. Press F1 for details on using this form.
� On the Export Data to Station form, Export section, select the

export options, then press OK to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Specify a Sort order/priority if there are multiple tasks that run
together and need to be run in a certain order. Ordered tasks must
start with a task with a Sort order/priority equal to "1". Leave
empty for stand-alone tasks.

� If you are running an external application, check Wait for an
external process to complete before continuing to initiate automated
task after the specified external application is finished running.
This can be useful if used before another task that should not be run
until an external process finishes.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.
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Import from Station Task
The Import from Station task is used by the central station to import
the outlying station’s information into the main database.

To Set Import to Station Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Import to Station.
� Press Setup Task Parameters... The Import Data from Station

form is displayed. Press F1 for details on using this form.
� Press Directory... to define where the file is located then press OK

to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Import External Data Task
Import External Data option is used to import external data sources
directly into specified FH tables.
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To Set Import External Data Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Import External Data.
� Press Setup Task Parameters... The External Data Imports form

is displayed. Press F1 for details on using this form.
� Add a new import definition or select an existing definition, then

press Save to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Run Database Tools Task
The Database Tools option is used to maintain your database.

To Set Run Database Tools Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
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� Select Run Database Tools.
� Press Setup Task Parameters... The Database Tools form is

displayed. Press F1 for details on using this form.
� Press OK then complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Backup Database Task
The Backup Database option is used to create a backup copy of the
database. We suggest that you backup your database on a regular basis
to minimize the risk of losing data.

As an alternative to an automated task, you can
automatically check for an up-to-date backup when exiting
FH. This setting is available on the Administrative
Options form Database section by checking Prompt for
database backup every... and specify the number of days.
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To Set Backup Database Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Backup Database.
� Press Setup Task Parameters... The Backup/Restore form is

displayed. Press F1 for details on using this form.
� Make selections then press OK to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Run External Application
The Run External Application option is used to run programs other
than FH.

To Set Run External Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
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� Select Run External Application.
� Press Setup Task Parameters... The Select Application form is

displayed. Press F1 for details on using this form.

� Select the external program to run, then press Open and complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Run Add-On Task
The Run Add-On option allows you to run add-ons that have been
added to your FH program.

Add-ons are utilities that perform various tasks related to your FH
system.

To Set Run Add-On Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Run Add-On.
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� Press Setup Task Parameters... The FIREHOUSE Software
Add-Ons form is displayed. Press F1 for details on using this form.

� Highlight the desired add-on and press Select and complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Print a Report Task
This option allows to you to automatically run and print reports.

To Set Report Print Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Print a Report.
� Press Setup Task Parameters... The Reports form is displayed.
� You can either select an existing report or create a new one.
For more information on creating a new report see Chapter 8, “Creating and
Modifying Reports”.
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� Add a new report or select an existing report, specify output, add
parameters then press OK to complete.

� Type an Automated Task Name.
Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Run a Query Task
This option allows to you to automatically run queries.

To Set Query Run Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Run a Query.
� Press Setup Task Parameters... The Queries form is displayed.
� You can either select an existing query or create a new one.
For more information on creating a new queries see Chapter 7, “Creating Queries”.
� Highlight desired query and press Select.
� Specify output options, then press OK to complete.

Setup Automated Tasks40

Workstation
Listing



� Type an Automated Task Name.
Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

NFIRS Transaction File Import Task
This option allows to you to automatically run NFIRS transaction file
imports.

To Set NFIRS Import Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select NFIRS Transaction File Import.
� Press Setup Task Parameters... The NFIRS 5.0 Import form is

displayed. Press F1 for details on using this form.

� Select the file to import, then press the Options tab and specify a
directory for the processed files.

� Press OK to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.
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� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

EMS Transaction File Import Task
This option allows to you to automatically run EMS transaction file
imports.

To Set EMS Import Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select EMS Transaction File Import.
� Press Setup Task Parameters... The FH 5.0 EMS Import form is

displayed. Press F1 for details on using this form.

� Select the file to import, then press the Options tab and specify a
directory for the processed files.

� Press OK to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
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• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.
• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.

Update Scheduling Activity Task
This option allows to you to automatically update scheduling activities
created from the Staff Scheduling module (optional feature).

To Set Update Schedule Activity Parameters
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Press New. The Automated Task Properties form is displayed.
� Select Update Scheduling Activity.
� Press Setup Task Parameters…
� Select the schedule to update.
� Press OK to complete.
� Type an Automated Task Name.

Use a name that clearly differentiates this task from other
automated tasks.

� Specify Run How Often? for how frequently the task is run. Choices
are:
• Daily and Time of Day.
• Weekly, Day, and Time of Day.
• Monthly, Day, and Time of Day.
• Timed and Every x minutes.
• Login.

43Adding Automated Tasks

Workstation
Listing



• Logout.
• Exit.

� Check Run task at the following workstation only to designate the
specific workstation to run this task from.

If the same workstation is listed multiple times, you need to
perform some workstation maintenance. See the FH Help
File ‘Workstation Administration’ topic for more
information.

� Check Run task from login screen only to run automated tasks only
when the FH login form is displayed.

� Check Exit FIREHOUSE Software after task completes to
automatically close the program after the task is finished. This
option is available if the Run task from login screen only is checked.

� Save and close.
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Use Automated Tasks

Once the automated tasks have been added, they are ready to be run at
the user-defined interval. The task processor needs to be active for
automated tasks to be run.

Launching the Task Processor
The task processor must be active for FH to scan automated tasks that
have been added and run them when appropriate. You can define when
the task processor is run.

To Specify Default Task Processor Status
� Access the Tools menu Workstation Options option, and select the

Other... section. In the Automated Tasks area, select the task
processor status:
� Select Auto-load on FIREHOUSE Software Startup to activate the

task processor when FH is launched. Automated tasks will not
be run unless FH is opened.

� Select Auto-load on Windows Startup to activate the task
processor when Windows is opened. Automated tasks will run
even if FH is not opened.

� Select Disable Automated Task Processor to disable the task
processor. Automated tasks will not be run until the task
processor is enabled.

When the FH task processor is activated, an FH icon is added to the
taskbar next to your Windows clock. Click on the FH icon to display
the Automated Task Status form, which allows you to suspend or
stop the task processor. Press Suspend to halt processing, but leave the
FH icon on the taskbar. Press Stop to halt processing and remove the
FH icon on the taskbar.

You can also manually start the automated task processor after adding
an automated task. From the Automated Task Setup form, press
Start in the Task Processor Status area. The automated task
processor is activated.

Run Automated Tasks
Automated tasks are run at intervals specified by the user, but can be
run manually at any time.
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To Manually Run Task
� Select the Administration menu, Automated Tasks... option. The

Automated Task Setup form is displayed.
� Check Show automated

tasks assigned to this
workstation only to limit
listed tasks.

� Highlight the task from the
list, then press Run.

The Task Processor Status
section displays information
about the processor status (for
example, 'Stopped' or
'Suspended') and includes
buttons for starting, stopping,
or suspending the task
processor.

See page 44 for more information on the Task Processor Status.

Review Automated Task Activity
The log section lists by date the individual automated tasks that have
been run.

To Review Automated Task Activity
� Highlight a log entry and

press the Details button.
� Details about the log and

when it was last
completed are displayed.

� Press OK to exit and return
to Automated Task Setup
form.
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Station Management

Station Management options include maintaining the station roster and using export
to/import from station to share data between stations.

• The station roster is described on the following page.
• Using Export To/Import From is described page 50.
• Additional Export To/Import From information is provided on page 54.

Export To/Import From is generally used when a high speed network is
not available. If you have high speed connections or use FH Enterprise, all
workstations should be connected to a single, central database and you
will not need to use Export To/Import From. FH Enterprise is a
client/server database version of FH. Contact your sales representative for
pricing information.

Chapter 5
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Maintain Station Roster

The Station Roster lists units and personnel that can be added to
incidents. When unit or personnel are added to the Station Roster, the
units and personnel are available via the Staff Group Select form
Station Roster section so they can be quickly added to incidents and
staff activities.

Specify that available units and staff are displayed when
adding groups of personnel from the Administrative
Options form, Staff section, by selecting Station Roster in
the Default Group Select Method.

Setting Station Roster
The station roster lists available units and personnel. The list of
available units and personnel are typically added by personnel at the
beginning of the shift. Please note that with the optional Staff
Scheduling module, the station roster could be locked from
modification, and updated using scheduling information.

To Add Units to Roster
� From the File menu, select Station Management, Station Roster

& Availability option. The Station Roster & Availability form,
Unit Roster section is displayed.

� Press Add in the Unit area.
The Station Roster -
Available Unit Detail
form is displayed. Add a
code to Unit, then save and
close.
The Staff Assigned caption
changes based on the
highlighted unit.

� Press Add Group next to
the Staff Assigned area and
select all staff members to
associate with the unit.
You can add staff one at a time by pressing Add. Repeat the steps
above for each unit and staff member associated with the unit.

� Save and close.
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To Add Personnel Not Associated with a Unit
� From the File menu, select Station Management, Station Roster

& Availability option. The Station Roster & Availability form,
Unit Roster section is displayed.

� Press the Personnel Roster
tab.

� Press Add Group,
highlight personnel, then
press OK.
The units and personnel
added to the Unit Roster
and Personnel Roster
sections are immediately
available from the Staff
Group Select form Staff
Roster section.

Specify that available units and staff are displayed when
adding groups of personnel from the Administrative
Options form, Staff section, by selecting Station Roster in
the Default Group Select Method.

� Press Close to exit the form.
With the Station Roster & Availability form displayed, press F1 for more
information on using this form.
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Using Station Export and Import

FH includes the ability to share data across a distributed network, even
when connection speeds are not high. Station Export/Import is a two
step process, the station export and sation import.

Export Data to Station
Export selected FH data, for sharing data between stations that do not
have a high-speed connection.

To Define Station Export
� From the File menu, Station Management option, select Export

Data to Station… option. The Export Data to Station … form is
displayed.

See 'Using Import/Export to Share Data' on page 54 for an overview of the
Import/Export process.
� Select databases to export

records from:
� Check each database to

include in the export.
� Press Select All to

select all databases, or
press Select None to
clear all exportable
selections.

Station
Roster,
Lookup
Tables, and Users and Security add a substantial amount of
data to export files, and are usually only exported from the
central station to outlying stations when the program is first
configured. When selected, Station Roster, Lookup Tables,
and Users and Security are exported in their entirety.

� Enter a Last saved on or after value:
� Select “Last Export” to include records in selected databases

added after the last export was created.
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� Select a dynamic date (”Yesterday”, “This Week”, “This Month”,
“Last Week”, “Last Month”) to include records in selected
databases created after the designated date. For example,
“Yesterday” includes all records saved on or after yesterday
(today’s date minus one).

� Select “Custom Date...” and specify a Date to only include records
in selected databases created after the defined Date. if Date is
left empty, all records in selected databases are exported.

� Select a code from any of the lookup code lists for: Station, District,
Shift, or Zone to include only records from selected databases for
the specified items. Leave the fields blank to export all records from
the selected databases.

� Check Exclude Today to exclude all records with the current date
from the export.

� Check Delete data source records after export to delete the dated
exported records from the exporting station, once the export is
complete. If selected, Station Roster, Lookup Tables, and Users and
Security are not deleted

� Check Export attachments for selected records to automatically
export attachments along with their respective records.

� Check Export user fields for selected records to export user field
values and user field attributes when used in selected records.

� Check Include records imported on or after above date to include
records imported in the specified time (even if the record’s date is
not in the specified time).

Imported records are not given a ‘new’ modified date
when imported, so a record that is imported into a
database will not be included in an export if the original
modified date of the imported record precedes the export
date. Check this option if the exported databases are
imported (and overwrite) records at another workstation.

� Check Exclude records with blanks in filter fields to exclude records
where the Station, District, Shift, or Zone fields have been left
empty.

� Press Directory... and use the file dialog to select a directory. The
export file must be exported to a location the importing FH
workstation can access so it can be imported. You can use a disk,
modem, or any other connection method to move the export file to a
location accessible to the importing FH workstation.

� Check Erase any previous export files in this directory to
automatically erase any export files found at this location.

� Type a path to an executable in When finished, execute the
following program to execute the designated program once the
export is finished. For example, you could run a batch file that
connects to a separate computer and sends the file.
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� To select a program, press File.... and use the dialog box to
locate and select the desired program. FH support is not able to
provide assistance for setting this functionality up.

� When finished with the export specifications, press OK to start the
export.

To Review Export History
� From the File menu,

Station Management
option, select Export Data
to Station… option. The
Export Data to Station …
form is displayed.

� Press the Log tab.
� Highlight a log entry and

press Details to get more
information on any of the
listed exports.

� Check Show exports
performed at this
workstation only to display exports run from that workstation.

Import Data from Station
Import files created by the FH Export to Station option, for sharing
data between stations that do not have a high-speed connection.

See Using Import/Export to Share Data on page 54 for an overview of the
Import/Export process.

To Define Import
� From the File menu,

Station Management
option, select Import Data
from Station… option.
The Import Data from
Station … form is
displayed.

� Press Directory... to define
where the export file is located.

� Check Erase source files after import to delete the source files after
the import is finished.

Station Management52



� Specify how duplicate records are treated during the import. A
record is considered to be a duplicate if the key field (or fields for
fire and EMS incidents) for the source record matches the target
record.
� Select Skip Duplicate Records to skip importing records that

have the same identifier.
� Select Overwrite Duplicate Records to import records, even if the

target has a matching record.

Select Skip Duplicate Records for imports if you are sure
that the workstation contains the most up-to-date records.
Note that if the two stations have duplicate records and
one station updates a duplicate record and exports the
record to another station that skips duplicates, the updated
record will be skipped. For example, if Station 2 (an
outlying station) creates an incident, then exports the
incident to Station 1 (central station), Station 1 modifies the
incident record, then exports the incident record back to
Station 2, the incident record will be skipped by the import
if Skip Duplicate Records is selected for the import. Incident
records should be locked upon completion to minimize
unauthorized changes.

If the central station typically makes changes to records
exported from the outlying stations, Overwrite Duplicate
Records needs to be selected for all outlying station imports
to ensure that the most up-to-date records are imported.
After records created at outlying stations have been
exported to the central station, all subsequent changes
must be made at the central station.

� Specify whether new directories are created as needed or specify
one directory that all attachments are saved in.
� Select Create new directories as needed to create a new

directory only when an attachment is imported (a new directory
for each attachment is created).

� Select Place all attachments in the following directory to specify
where imported attachments will be located.

To define a directory, first press Directory.... Use the dialog box
to locate and select the desired directory.

� Specify how imported records will affect existing incident records.
� Check Batch update completion status of imported incident

reports to automatically batch update incident completion status
when completion information from outlying stations is imported.
This will affect your state export transaction file if incident
status changes, so check only when sure of the results.

� When finished with the import specifications, click OK to start the
import.
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To Review Import Log
� From the File menu, Station Management option, select Import

Data from Station… option. The Import Data from Station …
form is displayed.

� Click the Log tab.
� Highlight a log entry and press Details to get more information on

any of the listed imports.
� Check Show imports performed at this workstation only to limit

displayed exports.

Using Import/Export to Share Data
Distributed networks vary widely. A network is a collection of
computers that share information. This loose definition could include a
collection of stand-alone workstations connected by a
“sneaker-network” using removable media to transfer data, or
computers connected by ISDN, microwave, or other connection
methods. The following is not a primer on available networks, but a set
of guidelines for keeping FH data up-to-date department-wide
regardless of the type of network you use.

Basic Setup Steps

The basic steps to configure FH data sharing are to:

• determine how you will be sharing data,
• determine who needs what data, then
• define the import/export.

Once these steps are defined, you can add automated tasks that will
automate these steps.

Determine Connection

How you choose to connect should be based on available software,
budget, and technical resources. A connection can be as simple as a 3
½” diskette physically carried from one computer to another, or more
complex, like a dedicated link between two LANs using a satellite link.
Your connection can be dedicated or dial up, depending on whether you
have a line to spare, or want to be able to use the line for other
purposes or needs.

Determine Data Coverage Needs

Determine how you want to share data throughout the network. A
common setup is to have the remote and central stations have their
own databases that are kept up-to-date using the station management
Export to/Import from options. Typically, the export to and import
from are automated tasks.
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Define the Import/Export

Below are the steps to export data from an outlying station and import
the files at the server, then back again. Generally, export and import
are used because a network connection is not available, or the
available connection is not sufficient for a dedicated connection. Each
FH workstation uses its own database. Base information like master
records, lookup codes, and user-defined fields should be synchronized
to export and import between two FH databases.

A license for each concurrent user is required. Each outlying station
and the central station needs a license. Some departments need an
extra license at the central station that exclusively runs automated
tasks. If you are unsure about your licensing status, please contact
your sales representative.

� At Station 2, access the File menu, Station Management option
Export Data to Station... option and direct the files to a specific
directory or diskette.

� From a workstation at Station 1 with FH running, go to File menu,
Station Management option Import Data from Station... option. The
Import from Station form is displayed.

After successfully importing the files, Station 1 will have all station
records included in the export.
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If you need to export Station 1 data to Station 2, then:

� From the workstation at Station 1 with FH running, go to File menu,
Station Management option, Export to Station option and select the
directory/diskette containing the files.

� From the workstation at Station 2, go to File menu, Station
Management option, Import from Station option and select the
directory/diskette containing the files.

Moving the Files

FH does not care how you get the files to the server; you can use
removable media, internet, Windows dial-up networking, or
third-party communication packages like PCAnywhere.
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User-Defined Fields

User-defined fields can be added to specific record areas of FH. Once added, the
user-defined fields are entered from the Other section of the user-defined field’s
record area. This chapter describes the intent of user-defined fields, lists areas that
user-defined fields can be added to, and details the steps to add user-defined fields.
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The Idea Behind User-Defined Fields

User-defined fields allow you to track information that the standard
FH package does not track. For example, if you wanted to track the
shoe size of staff members, you can add a "shoe size" field and add that
information to the staff member’s record from the Staff form, Other
section User Fields... button. Once a user-defined field is added to FH
and you start entering values into the user-defined fields, you can
create custom reports that list values from the user-defined fields and
include fields from the master record. For example, the report could
list staff member’s shoe size and their first and last name.

Check for available fields in FH. The information you want
to track using a user-defined field may already be tracked
elsewhere in the system.

User-Defined Fields58

User-Defined
Fields



Available User-Defined Field Areas

The areas that user-defined fields can be added to, and the
corresponding form from which user-defined fields are accessed, are
listed below.
Available Area Form Name
NFIRS Incident Reporting

NFIRS Incident Report User fields NFIRS Incident Report form
Incident Involvement User fields Involvement form
Civilian Casualty User fields Civilian Fire Casualty Report form
Fire Service Casualty User fields Fire Service Casualty Report form
Arson Report User fields Arson Report form

Arson - Suspect/Involvement User fields
Investigative Leads/Involvement Report
form

EMS/Search & Rescue Incident Reporting
EMS/Search & Rescue Incident User fields EMS/Search & Rescue Report form
EMS/Search & Rescue Patient/Victim User
fields

Patient/Victim Information form

Occupancy & Inspection Management
Occupancy Inspection/Activity User fields Inspection form

Occupancy User fields Occupancy form

Occupancy Contacts User fields Contact Detail form

Occupancy Permit User fields Permits form

Occupancy Chemical Inventory User fields Chemical Inventory form

Staff Management
Staff Activity User fields Activities form
Staff Activity Participant User fields Participants Detail form
Staff Member User fields Staff form
Staff Contact User fields Staff Contacts form

Training Classes & Programs
Training Program User fields Training Program form
Training Program Enrollee User fields Training Program form
Training Class User fields Training Class form
Training Class Attendee User fields Training Class form

Apparatus, Equipment & Inventory
Apparatus/Equipment & Inventory User fieldsInventory form
Maintenance/Test User fields Maintenance/Test Detail form
Vendor User fields Vendor form
Vendor Contact User fields Vendor form

Hydrant Management
Hydrant User fields Hydrant form
Hydrant Activity User fields Hydrant Inspection form
Hydrant Contact User fields Contact Detail form

Department Journal & Events
Department Event User fields Department Event form
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Anatomy of a User-Defined Fields Form

User-defined fields are always associated with a specific
record type. Values for the user-defined fields are always
added from the Other section of the associated record
type. See page 59 for a list of available record types and
their corresponding data entry form. See page 61 for the
steps to add user defined fields.

The anatomy of a complete User Fields form is illustrated below.
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Edit Box. See page 66 to add.

Label. See page 63 to add.

Page section. See page 62 to add.

Option Group. See page 67 to add.

Status Bar. See page 62 for details.

List Box. See page 69 to add.

* Combo Box. See page 68 to add.

Spinner. See page 70
to add. Check Box. See page 68

to add.

Text Box. See page 64 to add.

Form caption. See page 61 to modify.

The different types of fields you can add are detailed on
page 64.

* available Combo Box options are only displayed when
the down arrow is clicked. The pictured Combo Box is

‘opened’.



Layout Form

During the layout process, you specify the User Fields form’s
“run-time” appearance and define field layout. When you add a
user-defined field, a field is added to the User Fields form and to the
user-defined field table.

Before adding the user-defined fields to the User Fields form, consider
how the fields will be arranged on the form. You can title the form and
add multiple pages to the form to group related fields, and minimize
clutter. We do not recommend adding multiple pages to a User Fields
form unless you have specific reasons for doing so.

The User Fields Toolbar provides buttons for adding user-defined
fields and specifying the user-defined field form layout.

About Form Options
Form options include
specifying the caption at the top of your User Field form, setting the
sequence the cursor travels through the fields when Tab is pressed, and
adding available form sections. After selecting a specific record type to
add user-defined fields to, complete the following steps:

See “Access User Field Setup” on page 62 for the steps to access a specific
user-defined field.

To Access User Field Layout Form

User-defined fields can be initially setup directly from the
form where they will be entered. To set up user-defined
fields for the first time, access the Other section of the form
where the user-defined field will be added and press User
Fields... then answer Yes to prompt.

The user-defined fields can be added or modified from the user-defined
fields area.
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� From the Administration menu, select User-Defined Fields...
option. The User-Defined Fields Setup form is displayed.

� Press next to the
specific record area you
wish to add user-defined
fields to. Specific data
tables for the area are
listed.

See the table starting page 59 for a list
of areas and the specific forms that
access the user field areas.
� Highlight the specific data

table you want to add
user-defined fields to
(Apparatus/Equipment &
Inventory is selected above).

� Press Setup. The User-Defined Fields form for the selected record
is displayed.

The process for adding user-defined
fields is detailed starting page 64.

To Set User-Defined Field
Form Options

1. Press . The Form &
Table Properties form is
displayed.

2. Type a caption to display
at the top of the User
Fields form in Form Caption.

3. Select a Field Tab Order:

To Add Sections to User-Defined Field Forms

You can add sections to a user fields form so related fields can be
grouped and separated from other groups of fields. These pages are like
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the sections in other FH data entry forms. You specify the tab
caption(s).

1. Press . The Forms & Table Properties form is displayed.

2. Select the Pages tab.

3. Press New. The Page Properties form is displayed.

4. Type a page caption to display in the tab.

5. Press OK.

Repeat steps 3 to 5 for each additional page.

� Press OK once you have finished creating pages.
See page 60 for an example of a two page User Fields form.

To Add Label to User-Defined Field Form
A label can be used to identify an area of the user-defined form.

� Press then position your cursor in the area you wish to add the
label to.

� Press your left mouse button. The Label Properties form is
displayed.

� Type the text for the label, then press OK. The label is inserted
where the cursor was originally positioned.
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About User-Defined Fields

All available control types, and the allowable data types for each, are
listed below.

Control Types

Cha
ra

cte
r

Num
er

ic

Int
eg

er

Date

Lo
gic

al

M
em

o

Text Box X X X X X

Edit Box X

Option Group X X X

Check Box X

Combo Box X X X

List Box X X X

Spinner X X

There are two additional control types associated with Text Boxes:

Text Box, Date Lookup X

Automatically created for Text Box controls with Date for Data Type.

Text Box, Code Lookup X

Automatically created for Text Box controls with Lookup Checked.

Adding User-Defined Fields to Form
Add fields to the form using the User Fields Toolbar. Available options
depend on the control type you select from the toolbar. When you add a
user field, you specify the field properties and place the defined field on
the User Fields form. Once defined, the field is simultaneously added
to a database and to the form.

To Add User-Defined Text Field

Access the User Fields form for the record type to add the user-defined
field to, then complete the following steps:
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See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new

field in Field Name.
Caption is automatically
filled with the value
entered in Field Name.
Edit this value if you want
the label displayed next to
the field to be different
than the field name.

� Select the appropriate data type, length, decimals (numeric only),
and formatting options. The data types, length and available
formatting options for each are listed below.

Data Types Length Formatting Options Notes

Character #254

Alpha Only
Numeric Only

Force Upper Case
Right-Align Text
Format As Time

If you Format as Time,
a length of 5 or 8 is

required.

Numeric #254 Display Blank if Zero
Leading Zeroes

Format as Currency

Specify the decimal
value in Decimals.

Integer 4

Date 8 None

Logical 1 None

� Type a message in Status Bar Message to display a message in the
status bar when the cursor is in the field.

To Make User-Defined Field Lookup Driven

If you want users to select values from an existing lookup category, or
you wish to create a list of valid values from which users can select,
you should make this field lookup driven. Only text fields that are
“character” data type can be lookup-driven fields. You can either select
an existing category (described below) or create a new lookup category
(described page 65).

� Check Lookup. The Category field becomes required.
� Specify the Category.

� To add an existing lookup table and category, press in the
Category field and select a category, then press Select.

� To add a new category, type the new lookup category name in
Category. When you save the field properties, you are prompted
to create the new lookup category.
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� Select Yes to the prompt and the entered category is
automatically added to the User Defined Field Codes lookup
table.

� Add valid codes to your new lookup category now by saving
the user-defined field, then pressing next to the new
lookup-driven user-defined field you created.

What’s Next?
Display the Rules section to specify rules or default values for the
user-defined field. For more information, go to page 71. Otherwise,
save the new field properties.

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the user-defined field form.

To Add Edit Box

With the User Fields form displayed, complete the following steps:

See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new

field in Field Name.
Caption is automatically
filled with the value
entered in Field Name.
Edit this value if you want
the label displayed next to
the field to be different
than the field name.

� The Status Bar Message display messages associated with each field
in the status bar when the cursor is in the field.

� Check Force Upper Case if you want all text entered in the
user-defined field to be capitalized.

What’s Next?
Display the Rules section to specify rules or default values for the
user-defined field. For more information, go to page 71. Otherwise,
save the new field properties.

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the User Fields form.
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To Add Option Group

With the User Fields form displayed, complete the following steps:

See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new

field in Field Name.
Caption is automatically
filled with the value
entered in Field Name.
Edit this value if you want
the label displayed next to
the field to be different
than the field name.

� Select the appropriate data type:
• Integer (default).
• Character, and specify a length up to 254.

� The Status Bar Message display messages associated with each field
in the status bar when the cursor is in the field.

� Optionally add rules or default values. Display the Rules section to
specify rules or default values for the user-defined field. For more
information, go to page 71. Otherwise, add options (below).

� You must add options for the options group. Each option you add
will be added as a radio button:
� Press the Control tab to display the Control section.
� Place your cursor in the

text area and type the
text for the first option.
If you are adding an
additional option, press
Enter and type text for
the additional option;
otherwise, skip to the
next step.

Values for Integer type option groups are entered into the
user field table as "1" for the first option, "2" for the second,
and so forth. Character type option groups are represented
by the actual option text specified above. Note that if the
option group text is more characters than specified in
Length, that particular option will not be selectable from
the user form.

� Select Horizontal if you want options to display side by side.
Vertical places the options one over the other.
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� Specify the number of pixels to place between options in Button
Spacing.

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the User Fields form.

To Add Check Box

With the User Fields form displayed, complete the following steps:

See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new

field in Field Name.
Caption is automatically
filled with the value
entered in Field Name.
Edit this value if you want
the label displayed next to
the field to be different
than the field name.

� Type general information to display in the status bar when the
cursor is in the user-defined field in Status Bar Message.

� Optionally add rules or default values. Display the Rules section to
specify rules or default values for the user-defined field. For more
information, go to page 71. Otherwise, add options (below).

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the User Fields form.

To Add Combo Box

With the User Fields form displayed in layout mode, complete the
following steps:

See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new field in Field Name. Caption is

automatically filled with the value entered in Field Name. Edit this
value if you want the label displayed next to the field to be different
than the field name.
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� Select the appropriate data type:
• Integer (default).
• Character, and specify a length up to 254.

� The Status Bar Message display messages associated with each field
in the status bar when the cursor is in the field.

� Optionally add rules or default values. Display the Rules section to
specify rules or default values for the user-defined field. For more
information, go to page 71. Otherwise, add options (below).

� Press the Control tab to display the Control section.
� Place your cursor in the text area and type the text for the first

option. If you are adding an additional option, press Enter and type
text for the additional option; otherwise, skip to the next step.

Values for Integer type option groups are represented in
the user field table when selected as "1" for the first option,
"2" for the second, and so forth. Character type option
groups are represented by the actual option text specified
above. Note that if the option group text specified above is
more characters than specified in Length, that particular
option will not be selectable from the user form.

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the User Fields form.

To Add List Box

With the User Fields form displayed, complete the following steps:

See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new field in Field Name. Caption is

automatically filled with the value entered in Field Name. Edit this
value if you want the label displayed next to the field to be different
than the field name.

� Select the appropriate data type and length. Available data types
and lengths for each are listed below.
• Integer (default).
• Character, and specify a length up to 254.

� The Status Bar Message display messages associated with each field
in the status bar when the cursor is in the field.

� Optionally add rules or default values. Display the Rules section to
specify rules or default values for the user-defined field. For more
information, go to page 71. Otherwise, add options (below).
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� Press the Control tab to display the Control section.
� Place your cursor in the text area and type the text for the first

option. If you are adding an additional option, press Enter and type
text for the additional option; otherwise, skip to the next step.

Values for Integer type option groups are represented in
the user field table when selected as "1" for the first option,
"2" for the second, and so forth. Character type option
groups are represented by the actual option text specified
above. Note that if the option group text is more
characters than specified in Length, that particular option
will not be selectable from the user form.

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the User Fields form.

To Add Spinner

With the User Fields form displayed, complete the following steps:

See page 62 for the steps to access the desired user field form.
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type a name for the new field in Field Name. Caption is

automatically filled with the value entered in Field Name. Edit this
value if you want the label displayed next to the field to be different
than the field name.

� Select the appropriate data type, length, decimals (numeric only),
and formatting options:

Data Types Length Formatting Options Notes

Numeric #254 Display Blank if Zero
Leading Zeroes
Format as Currency

Specify the decimal
value in Decimals.

Integer 4

� The Status Bar Message display messages associated with each field
in the status bar when the cursor is in the field.

� Optionally add rules or default values. Display the Rules section to
specify rules or default values for the user-defined field. For more
information, go to page 71. Otherwise, add options (below).

� Press OK to save the user-defined field properties. The User Fields
form is displayed with the new field displayed where the cursor
was positioned. You may add another field or press Save to finish
the User Fields form.
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Setting Rules for User-Defined Fields
Rules and default values can be specified for all user field types.

To Specify Rules/Default Values for User-Defined Fields

With the User-Defined Field Properties form displayed:

� Press the Rules tab to display the Rules section.
� Enter rules or default values. Rules are divided into the following

types:
• Default Value. Specify value to default in the field so when a

new record is created, the default value is inserted.
See page 25 for more information on adding default values.

• Require. Specify that a certain field is required when the record
is entered in the User Fields form. When a field is required but
not complete, the field is listed as required in the validation
results when you attempt to save the record. Logical fields can
not be required.

See page 26 for more information on creating rules.
• Validation. Enter validation rule for the field to be valid. If the

field value is not valid under the rules you define, the field is
tagged as invalid. Entering a message in the Validation Error
Message field helps users correct their mistake.

See page 27 for more information on adding validation rules.
• Disable/Hide. Enter expression that, when true, disables field.

Check Remove field from page if above condition is true if you
want do not want the field to display when the expression is
true. Note that if all fields in a page are hidden, the page is also
hidden.

• Update Field. Select a field to replace, specify the condition to
meet, then enter the value or expression to use as a replacement
value in the Field to Replace.

� Press OK to save the rules.

Saving User Fields Form
After you have defined the form properties, laid the form out, and
added the desired fields, you can save the User Fields form.
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To Save User-Defined Fields Form

With the User Fields form that you just created displayed:

� Press Save. All field
additions and
modifications are listed in
the Confirm Update form
(if modifications were
made).

� Press OK. The
User-Defined Fields
Setup form is displayed.

You're ready to start using
your user-defined fields.

Modifying User-Defined Fields
You should not change user-defined field properties after data has been
entered into them. You can either remove fields from the User Fields
forms only, or remove the field from the form and the user field table.
If user fields are deleted after data has been added to the user field,
data will be lost.

To Remove User-Defined Fields from Form

Access the user-defined fields form to remove fields from, then
complete the following steps:

See page 62 for the steps to access user-defined fields forms.
� Position your cursor over the field to remove, then press your

right-mouse button. A menu of options is displayed.
� Select Delete Field... The

Delete Field prompt is
displayed.

� Select whether to remove
the field from the table and
form, or just the form:
� Select Delete the field

from the user fields
table to remove the
field from the User
Fields form and the
user-defined fields
table. Consider
carefully before deleting user-defined fields from user fields
tables, as these fields may be referenced in queries and reports
throughout your system and their removal may cause error
messages.
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� Select Remove the control from the form to remove the field
from the User Fields form and leave the field in the
user-defined fields table.

� Press OK.

To Review User-Defined Fields

You can view a list of all user-defined fields added for a specific area,
regardless of whether the user-defined field is included in a user field
form. After selecting the area to review user-defined fields for,
complete the following steps:

See “Access User Field Setup” on page 62 for the steps to access a specific
user-defined field.
� Press . The Form & Table Properties form is displayed.
� Access the Table section. All user-defined fields for the area are

listed.

If you are encountering errors as a result of a user-defined
field that is no longer used and for which entered data is no
longer required, you can highlight the user-defined field and
press Delete.

To Move User-Defined Fields

You can not move a user-defined field from one area to another (for
example, NFIRS Incident Report User Fields can not be moved to the
Occupancy User Fields area) but you can move a user-defined field
within the same area. For example, if you added a new page to the
user-defined field form.

Access the user-defined fields form to remove fields from, then
complete the following steps:

See page 62 for the steps to access user-defined fields forms.
� Position your cursor over the field to remove, then press your

right-mouse button. A menu of options is displayed.
� Select Cut Control. If a label is associated with the control,

highlight, press your right-mouse button, and select Delete Label.
� Access the new page added to the user-defined fields form.
� Position your cursor over the field to remove, then press your

right-mouse button. A menu of options is displayed.
� Select Paste Control. The control is pasted onto the form. Add a

label if necessary.
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Using User-Defined Fields
Once you have set up the user-defined fields, you are ready to enter
data. User-defined fields are always accessed from the main data entry
form Other section User Fields… button.

The list of areas that you can add user-defined fields to, and the corresponding data
entry form for the user-defined are listed on page 59.

When you press User Fields..., the user-defined form with the fields
you have added is displayed.
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Creating Queries

Queries are a powerful tool for gathering and using information entered into FH.
Queries drive the following:

• Browse lists of available records used to select specific records.
• Report forms that display information from your system. Reports can be

formatted to display information in a variety of ways and can include calculated
fields that statistically analyze data on the form.

• Graph charts that visually display your data.
• Map plots that visually display your data.
• Data Export definitions that create customized FH export files. Certain states

use this functionality to collect data not included in standard NFIRS and EMS
exports. Custom data exports that use Data Export type queries are only
available as installable components.

Browse lists and reports are an important part of getting the most out of FH. Browse
lists are displayed when you press the Browse button from data entry forms, and
are used to locate specific records, browse available records, and even to share
information with others by creating files in an external data format. You will use
reports to track important department statistics, to justify expenditures, and
manage resources. Graphs and maps are powerful tools for displaying your data
visually.

Queries gather data that has been entered into FH and formats the data for use in
browse lists, reports, graphs, and maps. Reports, graphs, and maps can include
multiple queries, browse lists only allow one. You can not add or modify the FH
data directly through a query.

A single query can be used in multiple places (for example, for a browse
list and a report). Bear in mind that if the multi-purpose query is changed
to suit a specific purpose (for example, to change the sort order for a
browse list) the change will also affect (and potentially invalidate) the
report that uses the same query.

Chapter 7
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Queries are structured questions that gather specific information from
available FH data. The information gathered by the query is stored in a
temporary file called the results table. Data from the results table can
be used to create reports and browse lists. Queries for reports are built
using the Report Setup form. Queries for browse lists are built using
the Query Designer form. The process for starting and completing
queries is detailed below.

1. Access Query. See page 77 for details.

2. Set Properties. See page 78 for details.

3. Select Tables. See page 81 for details.

4. Select Fields. See page 82 for details.

5. Join Tables. See page 87 for details.

6. Filter Results. See page 90 for details.

7. Order Results. See page 91 for details.

8. Group Results. See page 92 for details.

9. Limit Results. See page 92 for details.

10. Pivot Table. See page 94 for details.

If the query is already available, and you are creating a report, graph,
or map, additional details are available:

• The report design process is detailed in Chapter 8.
• The graph creation process is detailed in Chapter 12.
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Adding and Accessing a Query

New queries can be created from several locations based on whether
they will be used for a browse list, a report, graph, or map.

When you attempt to edit a query that is already in use, a
list of places the query is used by is displayed (if used by
other browse lists, reports, graphs, or maps). Avoid
modifying used queries since modifications could invalidate
the browse list, report, graph or map using the query.
Copy the query before changing it. FH automatically asks
you if you want to copy an existing query when you add a
new query.

To Add a New Query
� From Tools menu, select the Queries… option. The All Queries

form is displayed.
� Select the desired group.

Query groups correspond
to specific modules. Under
each query group are
subcategories that
correspond with specific
module records.

Note: Queries can be added during
the report or graph creation process
and from browse lists.
� Press New. The prompt

Would you like to start by
making a copy of an
existing query? is displayed. Copying an existing query can save
time since it will copy any joins, filters, and so on.
� If you selected Yes to prompt, the Select a Query form is

displayed. Highlight the query you wish to copy, then press
Select. The Query Designer form with information from the
copied query is displayed.

� If you selected No to prompt, the Query Designer form is
displayed.

� Complete the Query Designer form. The steps are detailed below.

To Access an Existing Query
� From Tools menu, select the Queries… option. The All Queries

form is displayed.
� Select the desired group and query then press Properties.
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� If prompted that the query is in use elsewhere in FH, press OK.
� If prompted that the query is a system query, press Yes.

Query Designer Properties
The Properties section contains descriptive information about the
query. The Properties section
is detailed below.

To Define Query Properties
� From Tools menu, select

the Queries… option. The
All Queries form is
displayed.

� Select the desired group.

We do not
recommend
modifying an existing query – it is better to make changes
to a copy of the original to prevent problems.

� Press New. The prompt Would you like to start by making a copy of
an existing query? is displayed. Copying an existing query can save
time since it will copy any joins, filters, and so on.
� If you selected Yes to prompt, the Select a Query form is

displayed. Highlight the query you wish to copy, then press
Select. The Query Designer form with information from the
copied query is displayed.

� If you selected No to prompt, the Query Designer form is
displayed.

� Type a title for the report in Query Name. Be descriptive as this
name is used in the list of queries.

� Check and select the category in Query Category.
� Select All Records to view all records or select Top Records... and

determine the percent or number of records you want to include in
the query results.

� Check Discard duplicate result records to display unique records
only.

� Choose where the query results will be available in the Query Types
area. Select any combination of the following query types:
• Browse. Used in browse lists for selecting records.
• Report. Used to gather information for reports.
• Graph. Used to gather information for graphs.
• Map. Used to gather information for maps.
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• Data Export. Used to gather information for custom data
exports.

� Check Make this the default query in this category to assign a
default query. There can be only one default query for each
category. The default Browse type query is displayed when you
press Browse from the data-entry form for the query category. For
example, the default Occupancy Management Queries: Occupancy
Queries category is displayed when you press the Occupancy form
Browse button.

� Check Define query manually through custom SQL commands to
manually enter Structured Query Language (SQL) commands to
gather data from FH tables. Not recommended for
non-programmers.

See “Customize SQL” on page 79 for steps to define queries using SQL commands.
� Check Generate a Pivot Table (Cross Tabulation) to analyze data as

three separate data elements. These three elements represent the X
axis, the Y axis, and the cell value for the graph.

When checked, you must complete the Pivot Table section. See page 94 for details.
� Add Comments to list in the lower left corner of the queries window

whenever this query is selected.

Custom SQL Statements
You can define a query using SQL statements if desired. Most users
don't need to create queries using custom SQL commands since the
standard query designer functionality is so powerful and easy to use.
Familiarity with SQL and FH data structures is required to customize
queries using SQL.

As you create a query using the Query Designer (that is, create the
query by selecting tables and fields, steps that are detailed later) FH
creates the necessary SQL commands to gather the data from FH. The
SQL commands can be viewed for your reference. The SQL commands
are read-only.

To Customize SQL
� From Tools menu, select the Queries… option. The All Queries

form is displayed.

� Select the desired group and query then press Properties.
� If prompted that the query is in use elsewhere in FH, press OK.
� If prompted that the query is a system query, press Yes.
� In the Options area, check Define query manually through custom

SQL commands. The View SQL button changes to Customize SQL.
� Press Customize SQL. The Query-Customize SQL form is

displayed.
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� Type valid SQL commands to gather specified values from FH data
tables and fields, then press OK when finished.

It is beyond the scope of this manual and FH technical support to cover SQL
commands.

To View SQL
� From Tools menu, select the Queries… option. The All Queries

form is displayed.
� Select the desired group and query then press Properties.
� If prompted that the query is in use elsewhere in FH, press OK.
� If prompted that the query is a system query, press Yes.
� Press View SQL then press Close when finished.

Modification History and Passwords
You can review the last user to modify the query, and the date the
modification was made. You can also require that a password be
entered before a query is run. A password must be entered anytime the
query is run (reports, browse lists, etc.).

To View Query Modification History
� From Tools menu, select the Queries… option. The All Queries

form is displayed.
� Select the desired group and query then press Properties.
� If prompted that the query is in use elsewhere in FH, press OK.
� If prompted that the query is a system query, press Yes.
� Press Query Modification History then press OK when finished.

To Password Protect a Query
� From Tools menu, select the Queries… option. The All Queries

form is displayed.
� Select the desired group and query then press Properties.
� If prompted that the query is in use elsewhere in FH, press OK.
� If prompted that the query is a system query, press Yes.
� Press Set Password... The Query Password form is displayed.
� Type the password for the query in Password then type the

password again in Confirm Password.
� Press OK. The query is password protected.
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Query Designer Tables
All available tables are displayed in the left-hand box of the Query
Designer form Tables section.
The right-hand box lists the
tables selected to be included
in the query.

To Add a Table to Query
� Access the query to add

tables to, then click the
Tables tab.

The steps to add a new query or
access an existing query are detailed
on page 77.
� Highlight the available table name in the left-hand box, then

double-click or press and the table is added to Selected Tables.
When you add a table, all fields in the table are available in the
Fields section.

When you add multiple tables, the tables need to have a common
field to relate the records in the two tables together. FH attempts to
determine the proper fields to “join” the tables on. You should check
all joins for accuracy, as improper joins will create invalid query
results.

See page 88 for more information on joins.
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To Display Table Properties
� Access the Query Designer form Tables section.
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the table name listed in Selected Tables and press

Properties... The Query Table Properties form is displayed.
• Table Source lists the

name of the database
and table using the
format:
DBC Name!DBF Name
where DBC Name is the
name of the database (the .DBC extension is not included) and
DBF Name is the name of the table included in the DBC (the
.DBF extension is not included). You cannot modify this field.

• Local Alias by default, lists the name of the table. This name is
used throughout the query when fields from the table are used.
You can modify Local Alias if necessary.

� Press OK to exit this form.

Query Designer Fields
All available fields and the fields included in the query are displayed in
the Query Designer form Fields section. The left-hand fields are the
fields in the tables you have
selected to add in the Table
section. The fields in the
right-hand box are fields you
select to add to the query.

To Add Fields from Table
� Access the Query

Designer form Fields
section.

The steps to add a new query or
access an existing query are detailed
on page 77.
� Select field or fields to add:

� To select one field, highlight the field name in the left-hand box
then double-click or press .

� To select a range of fields, click on the first list item in the range,
press Shift, then click the last list item in the range. All list
items between the first and last records in range are highlighted.
� Release the Shift key then press to add highlighted

fields to query.
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� To select items spread throughout the list (not adjoining), click
on a list item, press Ctrl, then click an additional list item,
repeating until all list items are selected.
� Release the Ctrl key then press to add highlighted fields

to query.
Certain master records include a field used to determine if the
record should be hidden. When this Hide field is added for the
query, the Query form displaying query results includes a checkbox
to show or hide ‘hidden’ records.

If Respect View Security and Privacy in Queries and
Reports is enabled via the Administrative Options form
Database section Rules and Security section, protected
information is masked in all queries and reports that do not
include the record ID field regardless of the security level
of the user. Include the ID fields for the following list of
tables to use this feature:
EMS Patient, EMS_PTNT.PTNT_ID
Incident Arson Involvements, INC_ASUB.SUSP_ID
Incident Civilian Casualties, INC_CCAS.CAS_ID
Incident Fire Service Casualties, INC_FCAS.CAS_ID
Incident Involvements, INC_INVL.INVL_ID

Adding Calculated Fields to Query
Calculated fields will perform a mathematical calculation on specified
data. There are the following available calculation fields available:

• Adding count fields to your query allows you to display the number
of occurrences of a specific field (either all records or unique
values). For example, you can list the total count of records.

• Adding Sum fields to your query allows you to add the values in
numeric fields together. For example, you can list the total sum of
values for a specific field.

• Adding Average fields to your query allows you to average the
values in numeric fields together.

• Adding Max fields to your query allows you to display the highest
value in numeric fields.

• Adding Min fields to your query allows you to display the smallest
value in numeric fields.

• A variety of other custom formats can be added. Available formats
depend on the format of the field. Select the Other button for preset
options available for the field.

• You can customize the value included in the query if you are
familiar with building advanced expressions in FH.
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To Add a Count Field
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field name in the left-hand box then press . You

are prompted to count all records, or distinct values.
� Press Yes to add a count of all records, and No to count only

distinct values.

When you count all records, every record is included in the
count. When a distinct count is used, only distinct values
are included. The distinct count will be equal to or less than
the total count.

Cnt, Sum, Avg, Max, Min, and certain Other... fields are
calculated fields. If a calculated field is added to the query,
you must add a “reset” point for the calculation in the
Group section, or the result table will include only one
record because there is only a single calculated field result.

Add Sum Field
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field name in the left-hand box then press .

Cnt, Sum, Avg, Max, Min, and certain Other... fields are
calculated fields. If a calculated field is added to the query,
you must add a “reset” point for the calculation in the
Group section, or the result table will include only one
record because there is only a single calculated field result.

Add Average Field
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field name in the left-hand box then press .

Cnt, Sum, Avg, Max, Min, and certain Other... fields are
calculated fields. If a calculated field is added to the query,
you must add a “reset” point for the calculation in the
Group section, or the result table will include only one
record because there is only a single calculated field result.

Add Max Field
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
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� Highlight the field name in the left-hand box then press .

Cnt, Sum, Avg, Max, Min, and certain Other... fields are
calculated fields. If a calculated field is added to the query,
you must add a “reset” point for the calculation in the
Group section, or the result table will include only one
record because there is only a single calculated field result.

Add Min Field
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field name in the left-hand box then press .

Cnt, Sum, Avg, Max, Min, and certain Other... fields are
calculated fields. If a calculated field is added to the query,
you must add a “reset” point for the calculation in the
Group section, or the result table will include only one
record because there is only a single calculated field result.

Add Other Field
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field name in the left-hand box then press .

The Additional Query Functions form is displayed.
Available options vary based on the field format. Highlight the
function to display a description of the function.

� Press OK.

Cnt, Sum, Avg, Max, Min, and certain Other... fields are
calculated fields. If a calculated field is added to the query,
you must add a “reset” point for the calculation in the
Group section, or the result table will include only one
record because there is only a single calculated field result.

To Add a Custom Expression to Query
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
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� Press Custom Field Expression… and the Query Custom Field
form is displayed.

� Enter a valid expression
for returning your custom
expression in Field
Expression or press
Expression Builder... to
display the Query
Expression Builder form.

Using the Expression Builder is
detailed page 125.
� Enter the name to use for the custom expression in Output Name.
� Type the name to display in the column heading (”Browse” queries)

or field (”Report” queries) in Field Caption.
� Check Pad field width to and specify the width to allocate for

custom field if you want to make the field a standard width (the
first value in the query results for the field will be used to set the
column width if this is not enabled.

� Press Format... to display format options
Format Options are detailed page 131.

Viewing and Editing Field Properties
You can view and modify the properties for fields listed in Selected
Output Fields.

To View/Edit Field Properties
� Access the Query Designer form Fields section:
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field and press Properties... The Query Field

Properties form is displayed. Note that the Query Custom Field
form is displayed if the highlighted field is a custom expression.
• Field Source displays

the source table name
and field name.
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• Output Name displays the field name. The value in this field is
used to name query fields (for example, when selecting a field to
sort by in the Order By section). You can edit this value if
necessary.

When multiple fields with the same name are entered, text
is appended to the end of the field name to avoid name
duplication.

• Field Caption is value used as a caption for the field in the
resulting report, graph, or browse list. For example, the caption
displayed at the top of the column of the Query form for
“Browse” type queries. You can edit this value if necessary.

� For "Browse" query types, check Display Field In Output to include
the field in the browse list. You may wish to exclude fields that
were only added to be used for sort order.

� Check Display Code Description to automatically include a
description for the code. Available only for lookup-driven fields.

� Check Count Distinct Values Only if you wish to count only distinct
values. If you wish to count each repeated value leave blank.
Available only for Count field.

� Press Format... to display format options (only available for
“Browse” type queries).

� Press OK to save changes, or press Cancel to exit without changing
properties.

Query Designer Joins
The Query Designer form Join section displays table joins. Joins are a
way of joining together related records from separate tables. Joins are
automatically added when multiple tables are added and the tables
share a common ID field. When more than one table is added, you are
prompted to specify the join type. Generally accept the default. Join
types are discussed in greater detail below. Do not add additional table
joins unless you have very specific reasons for doing so. The Join
section is only accessible when more than one table is selected in the
Tables section.

Improper joins can result in invalid data and unpredictable
query results. Allow FH to make entries where necessary
and only modify this area if you know exactly what you are
doing.
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To Add Table Joins
� Access the Query

Designer form Joins
section.

The steps to add a new query or
access an existing query are detailed
on page 77.
� Press Add. "Inner" is

inserted into the Type
column. Click the Type
column and select the
appropriate join types:
� Select Inner and only

the records that match
the join condition from both the source and target tables are
included.

� Select Left and all records from source table and only matching
records from the target table are included.

� Select Right and all records from target table and only matching
records from the source table are included.

� Select Outer and all matching & non-matching records from both
tables are included.

� Click in the Source Table column to select the source table. The
Source Table is where specified information originates from.

� Click in the Target Table column to select the target table. The
Target Table is where the information is imported to.

Adding Join Expressions
A join expression is automatically added when multiple tables with ID
fields in common are added. Each table join has its own join
expressions. When you add an additional table join, you need to specify
additional criteria for applying the join condition.

To Add Join Expression
� Access the Query Designer form Joins section.
The steps to add a new query or access an existing query are detailed on page 77.
� Press Add in the Join Expressions area. The cursor moves to the

Type column with “Join” selected.
� Click in the Type column to change the join expression type:

� Select Join to compare two field values.
� Select Value to compare field with values you specify.
� Select Var to compare field to a variable value.
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� There is an untitled column for nesting join expressions. This
advanced feature should not be used unless you are familiar with
nesting join expressions.

� Click in the Source column and select the field from the source
table.

� Check Not if you wish to exclude records where the join expression
is true.

� Click Criteria column and specify the criteria operator.
� Click in the Target column and select the field from the source

table.
� Check Case if you wish to ignore capitalization as criteria for

evaluating data (for example, FH sees “FoxTrot” and “foxtrot” as
separate values even though they use the same letters).

� There is an untitled column for nesting join expressions. This
advanced feature should not be used unless you are familiar with
nesting join expressions.

� Click Logical column if additional join expressions are to be added
and a logical is required. Logical column options:
� Select Or adds an “Or” between multiple criteria, so records will

still be found even if the first criteria is not met. For example,
you specify records with specific values in two fields or multiple
values in one field be included in a report. You want records
included even if the first criteria is not met, add two “Literal
Comparison” criteria with an “Or” between them. If you do not
add an “Or” between two criteria and the first criteria is not met,
no records will be included in the results table even if the second
criteria is met.

� Select And adds an “And” between multiple criteria, so records
will only be found if the first criteria and the second criteria are
met.

You are ready to add filters, described on the next page.
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Query Designer Filter Results
The Query Designer form Filter section includes parameters used for
narrowing the query results to specific records. Adding filters is not
required to complete a query.

To Add Filter Results
� Access the Query

Designer form Filter
section.

The steps to add a new query or
access an existing query are detailed
on page 77.
� Press Add. The cursor is

moved to the column
with “Value” selected.

� Click the column to
select a different filter type:
� Select Table Join to include records from two tables that have a

field that has the same value. You must have two tables selected
in the Table section, and a valid join requires that the two tables
share a valid relationship.

� Select Value to include records when a certain field contains a
value that meets certain criteria.

� Select Var to include records when a certain variable contains a
value that meets certain criteria.

� Select Ask to display a prompt that asks the user to specify a
certain value when the query is run.

� Select Custom and enter a custom expression that will include
records when criteria specified in the expression is met.

� Click on the Source column to display available fields. Any fields
listed in the Fields section are available.

� There is an untitled column for nesting join expressions. This
advanced feature should not be used unless you are familiar with
nesting join expressions.

� Check Not if you wish to exclude records where the filter expression
is true.

� Click the Criteria column and specify the criteria operator.
� Click in the Target column and select the field from the source

table.
� Check Ignore Case if you wish to ignore capitalization as criteria for

evaluating data (for example, FH sees “FoxTrot” and “foxtrot” as
separate values even though they use the same letters). This column
is automatically enabled for fields that are required to be
capitalized.
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� There is an untitled column for nesting filter expressions. This
advanced feature should not be used unless you are familiar with
nesting join expressions.

� Click the Logical column if additional filter expressions are to be
added and they are required.

Using “Or” and “And” is described page 89.
� Check Required? to make information required to perform filter.
� Check Allow Addition at the bottom of the form to allow additional

criteria to be added when the query is used.
You are ready to set the sort order, described on the next page.

To Remove Filter Expression
� Access the Query Designer form Filter section.
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight a filter expression then press Remove.

Query Designer Order By
The Query Designer form Order By section specifies how records in
the results table are sorted.
For example, if the browse list
or report lists staff members,
add the staff member’s last
name field in the Selected Sort
Field box to list staff names
alphabetically by last name.

To Sort By a Specific Field
Value
� Access the Query

Designer form Order By
section.

The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field name in the left-hand box then double-click or

press . Fields in the sort do not have to be in the results table.
You can add multiple fields to the sort order. See page 82 for steps to select more
than one field at a time.
� Press to sort records in ascending order (A to Z) based on the

values in the highlighted field.
� Press to sort records in descending order (Z to A) based on the

values in the highlighted fields.
Most queries are finished at this point. If necessary, set query group options, described
on the next page. If you have added calculated fields, you should complete query
group options.
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Query Designer Group Results
The Query Designer form Group By section defines the data element
used to reset counters. For
example, if you are listing
activities for a staff member,
you could add a Count field
(Fields section) that would
count activities for a
particular staff member and
the count would be reset to
zero when the staff ID
changed.

Only one
record is
displayed if a group is added but no Count field is added.
Counts are unpredictable if the sort order and groups do
not correspond.

To Define a Group By Field
� Access the Query Designer form Group By section.
The steps to add a new query or access an existing query are detailed on page 77.

� Highlight the field name in the left-hand box then double-click or
press .

Query Designer Limit Results
The Query Designer form Having section lists limiting fields that are
removed from the results table at the end of the querying process. The
difference between the Filter and Having section is the Filter section
filters out data before it is included in the results table. The Having
section filters out data that is included in the results table.
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Typically it
is not
necessary to
use the
Having
section

To Add Having Filter Results
� Access the Query Designer form Having section.
The steps to add a new query or access an existing query are detailed on page 77.
� Press Add. The cursor is moved to the column with “Value”

selected.
� Click the column to select a different filter type:

� Select Table Join to include records from two tables that have a
field that has the same value. You must have two tables selected
in the Table section, and a valid join requires that the two tables
share a valid relationship.

� Select Value to include records when a certain field contains a
value that meets certain criteria.

� Select Var to include records when a certain variable contains a
value that meets certain criteria.

� Select Ask to display a prompt that asks the user to specify a
certain value when the query is run.

� Select Custom and enter a custom expression that will include
records when criteria specified in the expression is met.

� Click on the Source column to display available fields. Any fields
listed in the Fields section are available.

� There is an untitled column for nesting join expressions. This
advanced feature should not be used unless you are familiar with
nesting join expressions.

� Check Not if you wish to exclude records where the filter expression
is true.

� Click the Criteria column and specify the criteria operator.
� Click in the Target column and select the field from the source

table.
� Check Ignore Case if you wish to ignore capitalization as criteria for

evaluating data (for example, FH sees “FoxTrot” and “foxtrot” as
separate values even though they use the same letters). This column
is automatically enabled for fields that are required to be
capitalized.

93Adding and Accessing a Query

Specialized Use



� There is an untitled column for nesting filter expressions. This
advanced feature should not be used unless you are familiar with
nesting join expressions.

� Click the Logical column if additional filter expressions are to be
added and they are required.

Using “Or” and “And” is described page 89.
� Check Required? to make information required to perform filter.
� Check Allow Addition at the bottom of the form to allow additional

criteria to be added when the query is used.

To Remove Filter Expression
� Access the Query Designer form Having section.
The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the having expression then press Remove.
Save the changes and most queries are ready for use. If this is a pivot table query, you
must complete the Pivot Table section.

Query Designer Pivot Table
The Query Designer form Pivot Table section is for defining a pivot
table to display the query results in. A pivot table summarizes data in a
spreadsheet format. The Pivot Table section is only accessible if
Generate a Pivot-Table is checked on the Properties section.

You specify fields for
columns, rows, and cells.
Each unique column field
value creates a new column,
and each unique row field
value creates a new row. The
intersecting cell contains the
cell field value, which may be
tabulated (for example, an
average). Available fields in
Available Cross-Tab Fields are
the fields added to the Fields
section.

To Generate a Pivot Table
� On the Query Designer Properties checkmark Generate a Pivot

Table (Cross-Tabulation).
� Access the Query Designer form Pivot Table section.

The steps to add a new query or access an existing query are detailed on page 77.
� Highlight the field to display across the top of the results table, then

press Column.
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� Highlight the field to display down the left side of the results table,
then press Row.

� Highlight the field to be entered in the intersecting cell position,
then press Cell.

� Specify field analysis type to define the appearance of the cell value:
� Select None to display the highlighted cell value as is.
� Select Count to display the number of cell values.
� Select Sum to tally all the values in each cell and display the

total.
� Select Avg to display the average value for each cell.
� Select Max to display the largest value for each cell.
� Select Min to display the smallest value for each cell.
� Check Count distinct values only to only count unique values

once.
� Check Add a subtotal column to each row containing... to add a

column at the end of the table.
� Number of cells in row containing data totals the number of

cells with values in each row.
� Sum of cell values in a row tallies the values in each row.
� Sum of cell values in a row as a percent of a grand total displays

the value percentage for each row.

Save the changes and the query will be displayed in a pivot table.

Query Designer Period Comparisons
Period comparisons allow comparisons between aggregate (for
example, count fields) data for distinct time periods. A date field needs
to be added to the Filter section with a 'Between' criteria comparison.

To Add Period Comparisons
� Access the Query Designer form Period Comparisons section.
The steps to add a new query or access an existing query are detailed on page 77.

Note that a date field with a 'Between' criteria operator
needs to be included in the query. At least one field in the
Group By section is also recommended.

� Select the number of comparisons to include in the results:
� '1' compares an initial user-defined start date with a

user-defined end date. Aggregate fields that calculate for the first
comparison period have a '1' appended to the display name.
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� '2' compares a second comparison period with an initial
user-defined start date with a user-defined end date. Aggregate
fields that calculate for the first comparison period have a '2'
appended to the display name.

� '3' compares a third comparison period with an initial
user-defined start date with a user-defined end date. Aggregate
fields that calculate for the first comparison period have a '3'
appended to the display name.

� Select a Date period filter variable.
� Define comparison period(s):

� Specify Move 1st Date To dynamic date the time period starts on.
� To start the period at the specified dynamic date, leave (+/-

number) as a '0'.  Optionally start the time period earlier by
specifying a negative number or after by specifying a positive
number.

� Specify the Move 2nd Date To dynamic date the time period ends
on.

� To end the period at the specified dynamic date, leave (+/-
number) as a '0'.  Optionally start the time period earlier by
specifying a negative number or after by specifying a positive
number.

A typical example of a comparison period would be to
Move 1st Date To 'Start of Calendar Year' and Move 2nd
Date To 'End of Calendar Year'. The second comparison
period would have the same values, except '-1' would be
specified in both (+/- number) fields for the second
comparison period.

Save the changes and the query will include calculated results for each
comparison period added.
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Creating and Modifying Reports

Reports can be modified or created from scratch. All reports include report design
properties, gathered data to display in the report, and the report design layout.
Reports included with FH can be directly modified, but we recommend that you
modify a copy of the report.

Chapter 8
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Report Creation Overview

To create a new report, complete the following basic steps:

� Specify the report design properties. Create and name the report,
then set basic options. You also specify available data within the
report design properties. Queries gather FH data for the report.
Select an existing query or build a new query.

See page 99 for more information on report design properties.
The procedure for completing queries are included in “Queries” on page 75.
� Specify the report design layout. Format the report to include

desired fields from the query.
The Report Designer layout is detailed in chapter 9.

An overview of the report creation process is detailed below.

Adding New Reports
Specify the report design properties. Create and name the report, then
set basic options. You also specify available data within the report
design properties. Queries gather FH data for the report. Select an
existing query or build a new query.

To Create a New Report from a Copy of an Existing Report
� Click on the Reports menu, and select the area you wish to add a

new report to. The Reports form is displayed with the selected
reports category open.

� Select the reports category
to add a report to. If
necessary, press next
to the report category to
display specific report
categories.

� Highlight the desired
report category, then press
New. You are prompted to
copy an existing report or
create a new report.

� Select Yes to the prompt.
The Reports form is
displayed.

� Locate the report you wish to make a copy of, then press Select.
The Report Designer form is displayed with the copied report
information. The report layout and report queries are copied.
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You can quickly locate specific reports using keywords.
Press Ctrl + F, type a keyword or phrase in the report
name, then press Find to locate reports matching your
text.

More information on specifying Report Designer form properties is included on page
99.

� Modify the Report Designer form properties as needed. See
‘Specify Report Designer Properties’ on page 99 for details. Save
and close when finished.

� Modify the layout as needed. Accessing and modifying the
Report Designer layout is detailed on page 118.

To Create a New Blank Report
� Click on the Reports menu, and select the area you wish to add a

new report to. The Reports form is displayed with the selected
reports category open.

� Select the reports category
to add a report to. If
necessary, press next
to the report category to
display specific report
categories.

� Highlight the desired
report category, then press
New. You are prompted to
copy an existing report or
create a new report.

� Select No to the prompt.
The Report Designer form
is displayed.

� Type a name for the report
in Report Name.

� Report Category contains
the report category
highlighted when the new
report was initiated. You
can modify the selected
report category if
necessary.

� Select "Report" in Report
Type:
� Select Report for a

standard printed report
form.

� Select Mailing Label for a printed label (for example, a mailing
label).
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� Select Batch Report for a collection of reports that print all
records for a report.

� Select Collated Report for a collection of reports that print a
record for each report, resulting in a collated collection of
reports for each record. The NFIRS Incident Report is an
example of a collated report.

The steps for creating a mailing label are similar. The procedure for creating a batch or
collated report is detailed on page 115.
� Type a descriptive phrase about the report in Comments. The

message will display in the Reports form status bar, and could help
users identify the purpose of the report without having to run it.

� Complete the options area:
� Check Make this the default report in this category to

automatically select the report when Print... is pressed from the
data entry form for the report category associated with a specific
data entry form. When no report in the report category
associated with the data entry form is "default", a list of reports
to select is displayed when Print... is pressed.

� Check Include this report on the Report Shortcuts menu to add
the report to the Reports menu Report Shortcuts submenu.
Reports included in this area are the most frequently accessed
reports for your department.

� Check Hide this report to prevent the report from being included
in the Reports form listing (unless Show Hidden Reports is
checked).

� Check Enable "Blank" print option if you want to be able to print
the report without any data. This is especially helpful if you
could use the report as a printed data entry form in the field.

� Check Use stored printer settings to save printer settings for this
report. Press F1 with the Report Designer form displayed for
more information.

You're ready to add a query. The query gathers the data for display
on the report form. Add an existing query, or create a new query.

� Press Add. The Queries form is displayed. We recommend that you
create a new query. If you know a query that already exists that
gathers the necessary data without modification, select the query
from the list. Otherwise, complete the next step.
� Press New. A prompt to copy an existing query is displayed.
� Select whether to copy an existing query or to create a new one:

� To copy an existing query select Yes and find a query to copy
or press Ctrl+F to search for the query using a keyword.

� To create a blank query select No. The Query Designer form
is displayed.

� Define or edit (if a copy was created) the query.
Creating and defining queries is described in Chapter 7.
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Be sure to include all of the information that you will include in the
report layout. When you're finished, save and close the new query.
The Queries form is displayed with your query highlighted.

� Press Select. The Report Query prompt is displayed.
� Change Query Alias Name only if you have a specific reason for

doing so.
� Check Don’t requery if alias name is already in use to not run

query if the alias name assigned to the query is already in use.
� Check This is the primary query if there are to be multiple

queries included in the report and the current query is the
primary query.

� Press OK. The query is added to the query area of the Report
Designer form.

Specifying the Report Design Layout Using Quick Form
When you create a new blank report, the report must be laid out using
the Report Design Layout after you have defined the report design
properties and added a query to gather the data for the report.

The steps create a report start in "Report Creation Overview", page 98.

The Quick Form option helps you quickly create custom reports by
automatically placing the
fields in the query in the
Report Designer layout.

Using Quick Forms is detailed on
the next page.

If you want to skip directly to
the report layout without
using the Quick Form option,
press Save then Close and a
blank Report Designer layout
is displayed.

Details for adding fields to a blank
Report Designer layout are described in “Access Report Layout” on page 118.

To Generate Quick Form
� Access the Report Designer form for the new report.
The steps leading up to the steps below start in "To Create a New Blank Report", page
99.
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� Press Form to display the Form section.
� Select a layout option in

Template Name:
� Select Column to

display fields
horizontally in
columns. You also need
to specify the number
of columns.

� Select Form to display
fields one below the
other.

� Press Generate Quick
Form Now (not available
if a Template Name: has not been selected) to display the Report
Designer layout with all fields selected in the query automatically
inserted.

See “Report Form Objects” on page 124 for  more information on available object
types.
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Sample Report

The following example walks you through the process of creating a
new report, then modifying the report.

The sample report will list staff last name, first name, middle initial,
and staff date of birth.

� Access the Reports menu, Staff, Activity, and Training Reports
option. The Reports form is displayed.

� Highlight Staff Master
Reports then press New.
You are prompted to start
by making a copy.

� Press No. The Report
Designer form is
displayed.

� Type “Staff Birthdays” in
the Report Name field.

� Type “List staff birthdays,
sorted by last name” in the
Comments area.

� Press Add. The Queries form is displayed.
� Press New. You are prompted to make a copy of an existing query.
� Press No. The Query Designer form is displayed.
� Type "Staff Birthdays" in

Query Name.
� Click the Table tab to

display the Tables section
of the Query Designer
form.

� Press STAFF in Available
Databases & Tables, then
double-click STF_MAIN to
add the Staff Members
table to Selected Tables.

� Click the Fields tab to
display the Fields section
of the Query Designer form.

� Add the following fields to Selected Field (you can highlight the field
then press the right arrow, or double click to add the field to the
results table):
LAST
FIRST
MIDDLE
DOB
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By specifying filter options, you are allowing the user to
specify criteria for selecting reports when they run the
report. You do not have to specify filter options, but
running reports that use queries without any filters will
include all records in the queried database; a disadvantage if
you have large numbers of records.

� Click Filter tab to display the Filter section of the Query Designer
form.

� Press Add, change Type to "Ask", place cursor in Source, and select
"LAST". The Query "Ask User" Parameters form is displayed.

� Press OK.
� Press Add, change Type to "Ask", place cursor in Source, and select

"STATUS". The Query "Ask User" Parameters form is displayed.
� Press OK. The finished Filter section looks like this:

� Click the Order By tab to display the Order By section of the Query
Designer form.

� Add the following field to Selected Sorts (you can highlight the field
then press the right arrow, or double click to add the field to the
results table):
STF_MAIN.LAST

� Press the Save button on the Query Designer form, then press
Close. The Queries form is displayed.

� Select the query you just created, "Staff Birthdays". The Report
Designer form is displayed.

� Press Form to display the Form section of the Report Designer
form.

� Select "Column" in Template Name, type "1" in Columns, and press
Generate Quick Form Now. If you have not saved Report
Designer form changes, you are prompted to do so.
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� Press Yes. The form is generated and the Report Designer layout for
the report form is displayed.

Accessing and modifying the Report Designer layout is detailed on page 118.
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Preview the Report

It is always a good idea to preview the report to see how it will look
before printing. With the Report Designer layout displayed:

� Access the File menu, Print Preview option. The report is
previewed on your screen.

� Select the File menu, Close option to return to the Report Designer
layout.

Widen Field in Report Layout

The preview showed some minor problems with the report. The DOB
field is too narrow, so the date of birth occupies two lines. This change
can be made now

� Click on DOB.

� Position the cursor to the right side of the DOB box, click and hold
the left mouse, and drag your cursor to the right.

� Release the left mouse button when it is a little wider (about ½ an
inch is sufficient).

� Select the File menu Save & Close option. The Report form with
the Staff Birthdays report highlighted is displayed.

Run Report
To run the report, complete the following steps:

� Highlight Staff Birthdays, then press Run. The Output Report To
form is displayed.

� Press OK without changing the output options. The Query
Parameters form is displayed.
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� Press OK. The report is previewed on the screen.

Report Change Suggestions

The sample report has a
number of areas that can be
improved.

• Combine the staff name
field into a single field and
remove unnecessary
spaces between first, last,
and middle names.

• Add more white space so
the printed report can be
three-hole punched.

• Change the report to two columns, so more information will fit on
each page.

• Allow user more flexibility for entering their own selection criteria
as they are running the report.

• Add the staff member's age to the report.
See the next page for the steps to modify a sample report.
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Modify Sample Report

The report we have just created is listed at the bottom of the reports
for the Staff, Activity and Training Reports category Staff Master
Reports subcategory.

Change Report List Sequence
You can arrange report names to appear in any order in the report list.
Access the Reports menu, then select the report category you wish to
modify.

For the report we have just created, select Staff, Activity and
Training Reports option. The Reports form is displayed.

� Highlight Staff Master Reports then press Options... A list of
options is displayed.

� Press Change List Sequence… The Report Sequence form is
displayed.

� Highlight the Staff
Birthdays report (it is
listed at the very bottom of
this form).

� Press and hold the left
mouse button down, then
drag the report to the
desired location in the list.

� Press OK, and the report
list sequence is changed.

Now, you're ready to modify
the report.

Modify the Sample Report
The Reports form is displayed, with the Staff Birthdays report listed.

� Highlight the Staff Birthdays report.
� Press Layout... The Report Designer layout is displayed.
See page 118 for more details about the Report Designer layout area.
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Combine First, Middle, and Last Name Fields in Sample Report

We will write an expression that combines the last, first, and middle
names of the staff member.

1. Double-click the Last Name field listed in the Detail band. The
Report Expression form is displayed.

2. Press the Expression
lookup button. The
Expression for Field on
Report form is displayed.

3. Delete the expression
entered in the Expression
for Field on Report box.

4. In the Expression for Field
on Report box, type
“trim(”.

Trim
removes
extra spaces
from a field
entered in
the expression.

5. Double-click the Last field listed in the Field: area, then type “)”.

6. Type “+’, ‘+”.

Typing a plus sign (+) in the Expression for Field on Report
box indicates that there is additional information. Anything
between the quotation marks will be included in the report
as it is typed in. There is a comma and a space between the
quotation marks, so a comma and a space will be added to
the end of the last name.

7. Type “trim(” then double-click on the first field, then type “)”.

8. Type “+’ ‘+”.
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9. Type “trim(” then double-click on the MI field, then type “)”. The
entire expression is displayed below.

10. Press Verify. If there are

any mistakes or errors in

the expression, an error

message is displayed.

11. Press OK and the
Expression Builder form
is closed.

12. Press OK and the Report
Expression form is closed,
and the Report Designer
layout is displayed (a
portion of the Report Designer layout is displayed below).

Remove Fields  in Sample
Report

Now that we have added a
single field that includes the
last name, first name, and
middle initial. The first name
and middle initial fields
included on the report are no
longer necessary.

1. Select the tool.

2. Position the cursor on the first name field and press the Delete
keyboard key.

3. Position the cursor on the first name label and press the Delete
keyboard key.

4. Position the cursor on the middle initial field and press the Delete
keyboard key.

5. Position the cursor on the middle initial label and press the Delete
keyboard key.

Tip Hold down the shift key to select multiple objects at one time.

Rename Labels in Sample Report

The label “Last Name” is no longer accurate since this field now
includes the last name, first name, and middle initial.

1. Select the tool.
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2. Move the cursor to the "Last Name" label, and double-click on the
Last Name field label. The entire label is highlighted.

3. Type “Staff Name”.

4. Select the tool.

5. Move the cursor to the DOB label, and double-click on the DOB field
label. The entire label will be highlighted.

6. Type “Birthday”.

Add Columns and Margin
Now that we have created a single field for the name, we are ready to
make the report two columns, and add space in the margins. Note that
the following steps are made while the Report Designer layout for the
report is displayed.

See "Modify the Report" on page 108 for the steps to access the Report Designer
layout.

Move Fields Together

Since we have removed several fields, there is unused space in the
middle of the report.

1. Select the tool.

2. Move the cursor to the center of the field you want to move, press
and hold down the left mouse button, drag the cursor to the new
location, then release the left mouse button.

Select multiple fields by pressing the Shift key and
selecting multiple objects.
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Add Columns and Margin

3. From the File menu, select the Page Setup... option. The Page

Setup form is displayed.

4. Type 2 in the Column area
Number field.

5. Type .75 in the Left
Margin: field. This inserts
space in the left column, so
you can 3-hole punch the
report without putting a
hole in data listed in the
report.

6. Press OK and the Page
Setup form is closed. The
Report Designer layout is displayed and Column Header and
Column Footer bands are added to the layout.

Add User Options
When the report is run, you can give the user additional options for
criteria for determining what records to include in the report, or in this
example, make it possible for the user to search for specific values in
any field added to the table added to the query (STF_MAIN in this
example).

1. From the File menu, Report Properties… option. The Report
Designer form is displayed.

2. Access the Query area, then press Properties... The Query in Use
form is displayed. Press OK and the Query Designer form is
displayed.

The Query in Use form is displayed any time you attempt
to open a query that is used by reports, graphs, or browse
lists. The function of the form is to inform you about
reports, graphs, and/or browse lists that use the query,
since modifying a query could invalidate the results.

3. Press Filter to display the Filter section of the Query Designer
form.

4. Check Allow addition of "filter" selections from available output
fields.
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When the report is run, the user can search for specific
records based on values in any field available in tables
added to the Table section of the Query Designer form.

5. Press Save then Close (or Ctrl + W) to return to the Report
Designer form.

6. Press Save then Close (or Ctrl + W) to return to the Report
Designer layout.

The next time the report is run, the user has more flexibility in
selecting specific records.

Add Age Field
The last thing we need to do to complete the report is to add a field
that will list the staff member's age.

Add Age Field

1. Click on the tool. Move the cursor where the field starts, hold
down the left mouse button, and move the cursor to where the field
ends. The Report Expression form is displayed.

2. Press to the right of Expression. The Expression For Field on
Report form is displayed.

3. Press Advanced to display the Advanced section. Available
functions that format data are displayed in Advanced Functions.

4. Double-click "Age". The Age function is inserted into the main
Expression for Field on Report field, with the first parameter
highlighted.

Press Details... for more information on each function
parameter. For this example, we will only use the first
parameter.

5. Press Fields to display the Fields section.

6. Double-click DOB. DOB is inserted into the Age() function.

7. Remove the optional parameters from the Age() function. The
finished Age() function should look like:
Age(Staff_birthdays.Dob)

8. Press OK to close the Expression for Field on Report, then OK
again to close the Report Expression form.
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Add Label for Count Field

9. Select the tool and move the cursor above the Age field.

10. Type “Age”.

11. Access the File menu Save and Close option when you are satisfied
with the appearance of the report.

Congratulations. You have created a custom report from scratch.
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Create Batch/Collated Report

First, complete the steps listed in "Report Creation Overview", pages 98
to 99.

Using Batch or Collated Reports, you can associate a
number of reports together. You can include reports from
a variety of areas, so each individual report can be simpler
(rather than a single report that includes all this information
in a single report).

1. Select Batch Report or Collated Report:
� Batch Report is a collection of reports that print all records for a

report. Each added report includes multiple records.
� Collated Report is a collection of reports that each print a single

record, resulting in a collated collection of reports for a single
record. The NFIRS Incident Report is an example of a collated
report.

2. Add the reports you wish to include in the batch or collated report.

3. Press Save then Close (or press Ctrl + W) and run the report.
The procedure for completing queries is included in “Queries” on page 756.
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Report Designer Layout Reference

Each report has a report layout that specifies how information will be displayed
when the report is displayed, printed, or saved to one of the supported file formats.

When you first create a new report or modify an existing report, the Report
Designer layout is displayed. Below is an example of the Report Designer layout.

Expand the visible Report Designer work area by pressing the maximize
button, or move the arrow to the lower right-hand corner of the form
and drag to enlarge the visible area.
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Access Report Layout

1. Click on the Reports menu, and select the desired report heading.
The Reports form is displayed with the selected reports category
open.

2. Select the reports category containing the report. If necessary, press
next to the report category to display specific report categories.

With the report highlighted, press Layout. The Report Designer layout
for the selected report is displayed.
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Report Bands

FH reports are banded. Each band serves a specific purpose. Each
available report band is described below.

Title Band

The Title band is an optional band that contains information that is
inserted in front of the main report, when included. The Title band
prints once for each report.

Tip Use the Title band to create a cover page for a report.
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Optional. Place title or
information that will

be printed one time at
the front of the

report.

Place fixed information like
report title. Automatically

completed when you use the
Quick Reports option,

included at the top of each
report page.

Report Designer Toolbar �

Optional. Place group title and label information.

Place data and descriptive
information in the Detail

band.

Optional. Place group totals and label information. Place fixed information like
dates and report pages.

Automatically completed
when you use the Quick

Reports option, included at
the bottom of each report

page.

Optional. Place title or information that will be
printed one time at the end of the report.

Scroll Bar. You may need to use the scroll bars to
see all objects on the form.



Add Title

Complete the following steps to add a Title band:

1. Select the Report menu, Title/Summary… option. The
Title/Summary dialog is displayed.

2. Check Title Band. If you want the Title band to be displayed on its
own page, check New Page.

3. Press OK, and a Title band is added to your report.

Page Header Band

Information added to the Page Header band is displayed at the top of
each page of the main report (the Title band is displayed above the first
Page Header when included). A Page Header can contain fixed data like
a report title or a column header, or variable data like query
parameters, and other information.

Column Header Band

When more than one column is selected for the form, data in the
Column Header band is displayed at the top of each column.

Add Columns

You can specify multiple columns from the Report Designer form,
Form section, or with the Report Designer layout displayed, select the
File menu, Page Setup... option.

You can specify as many columns as you want, but if the resulting
columns are too narrow, all the fields in the report will not fit.

Group Header Band

After designing the basic layout, you may decide that grouping the
records by certain fields or other criteria would make the report easier
to read.

Grouping allows you to separate groups of records visually and display
introductory and summary data for each group. The group break is
based on a grouping expression. This expression is usually based on
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one or more table fields but it can be as complex as you like. When you
have groups, your report layout has Group Header and Group Footer
bands, to which you can then add controls. Typically, Group Header
bands include the field used for the group. You may add lines,
rectangles, rounded rectangles, or any label you want to appear before
the first record in a group. Group Footer bands often contain group
totals and other summary information for the group.

You can also specify other options for the groups:

• Printing text in headers and footers to identify specific groups
• Printing each group on a new page
• Resetting page numbers when groups are printed on a new page

The report layout does not actually sort and order your data. The sort
order defined in the Query Designer form dictates the record order.

Add Group

Complete the following steps to add a group. You can add as many
groups as necessary, although multiple groups increase the complexity
of the report.

� Select the Report menu, Data Grouping… option. The Data
Grouping form is displayed.

� Press to add a new grouping or edit an existing grouping, Insert
to place a new grouping, or Delete to remove an existing data
grouping.

Detail Band

Details allow multiple items of specific information to be displayed.
Usually, data in the Detail band contains field information from one or
more than one table. The Detail band adopts the size of the column.

Group Footer Band

Display calculated fields that will contain descriptive information
about data contained in the related group.

See "Add Group" on previous page for information on adding groups.
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Column Footer Band
When more than one column is selected for the form, data in the
Column Footer band is displayed at the bottom of each column. Column
Footer bands typically display summaries and/or subtotals of the
information contained in the column.

Page Footer Band

Displayed at the bottom of each page of the main report, when
included. The Page Footer usually contains a combination of fixed and
variable information. Page Footer bands are useful for displaying
summaries and/or subtotals for data included on the page.

Summary Band

The Summary band is optional. Use the Summary band to create totals
for the report, or text that summarizes the contents of the report. Like
the Title band, the Summary band is printed once per report (the
Summary is included at the end).

Add Summary

The steps for adding a Summary band are listed below.

� Choose the Report menu, Title/Summary option. The
Title/Summary form is displayed.

� Check Summary Band to add a Summary band to your report.
Check New Page below the Summary Band to put the Summary
band on its own page.

� Press OK to add the selected bands.

Changing Band Size
Bands can be resized to fit information contained in the band. The area
for each band is defined by the amount of white space above each
band. Each band has a blue triangle button to the left of the band,
known as the move button. To resize a band, drag the move button up
or down to the desired size. If no white space is displayed above the
band, the band is not printed.
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Double-click the move button to display a dialog for setting the height
of the band in inches or centimeters. Check Constant Band Height to
force the band to maintain a constant height.

The Page Footer, Title, and Summary bands always have
Constant Band Height checked by default. Pay special
attention to the type of information you are adding to these
fields. Expandable data can cause overlapping text on a
printed report.
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Report Form Objects

Custom reports are created by adding and modifying objects to the
Report Designer layout.

Control Types
The Report Controls toolbar contains buttons for adding objects to the
form. The toolbar is displayed to the left of the Report Designer layout
or displayed below the main menu.

See page 118 for steps to access the
Report Designer layout.

Selection
Tool. Used to
select objects
on the report
form layout form.

Label Objects. Typically used to label specific
data or columns. Text objects display fixed
information you specify.

Field Objects. Display data from a field in the
results table created by the query, or from a
user-defined function.

Graphic Objects. Lines, rectangles, round
rectangles, and pictures available for reports.
Graphic objects are optional and typically will
highlight certain information or give the report a
more professional appearance.

Picture/ActiveX Bound Control. Add any
recognized graphic file, including OLE objects
attached to your records.

Button Lock. Press to lock the next selected
tool. For example, when adding multiple labels
to a form, button lock allows you to add
multiple labels without having to select the label
tool after adding each label.
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Add Field Objects
In Report Designer layout:

See page 118 for the steps to access the Report Designer layout.
� Add a field by pressing from the toolbar.
� Move the cursor where you want the field to start.
� Press and hold down the left mouse button, move the cursor to

where you want the field to end and release. The Report
Expression form is displayed.

To Set Field Expression
� Press and the

Expression For Field on
Report: form is displayed.

� Enter the expression for
the field. Fields from the
results table are listed in
the Fields: box in the
lower left portion of the
form. To add a field,
highlight the field in the
Fields: box, then double-click the field name. The field name,
preceded by the variable name assigned to the query, is added to the
Expression for Field on Report: box.

Use other options from this form if you are familiar with
FoxPro and advanced FIREHOUSE Software variables and
functions. Advanced functions are included in the Advanced
section. More information is available in the help file. Press
F1 in FH to display.

� After completing the expression, press OK. The Report Expression
form is displayed again.

� Set format options, then press OK.
See “Field Options” on page 127 for more information on the Report Expression
form.

Add Label Objects
You will generally add a label for each field. In Report Designer layout:

See page 118 for the steps to access the Report Designer layout.
� Press from the toolbar.
� Move the cursor to the area you want the text to be included in.
� Press the left mouse button, and type the text you want to display.
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Add Graphic Objects
There are a variety of different types of graphic objects that can be
added to report forms. In Report Designer layout:

See page 118 for the steps to access the Report Designer layout.
� To add lines:

� Press from the toolbar.
� Move the cursor to the area you want the line to start.
� Press and hold down the left mouse button, move the cursor to

where you want the line to end then release.
� To add rectangles:

� Add a rectangle by pressing from the toolbar.
� Move the cursor to the area you want the rectangle to start.
� Press and hold down left mouse button, move the cursor to

where you want the rectangle to end then release.
� To add rounded rectangles:

� Add a rounded rectangle by pressing from the toolbar.
� Move the cursor to where you want the rounded rectangle to

begin.
� Press and hold down the left mouse button, and drag the cursor

to where you want the rounded rectangle to end then release.
� To add pictures:

� Add a picture by pressing from the toolbar.
� Move the cursor to where you want the picture to start.
� Press and hold down the left mouse button, move the cursor to

where you want the picture to end then release. A dialog for
selecting the picture file is displayed.

Moving Fields, Labels and Graphics
There are a number of ways to move and align objects around on the
Report Designer layout.

See page 118 for the steps to access the Report Designer layout.

Move Objects Manually

You can have objects automatically snap to a grid, or you can disable
this feature. This feature is accessed from the Report Designer layout,
Format menu, Snap to Grid... option.

� Select the tool from the toolbar.
� Move your cursor to the object on the report form layout form.

Tip Double-click on the band separator bar to highlight all objects in the band.

Report Designer Layout Reference126



� Press and hold down your left mouse button and drag the object (or
objects) to the desired location.

� Double click the object to see options for the object.

Aligning Controls

You can align controls with each other using the Layout toolbar.

To align controls with each other
� Select the controls you want to align. Select multiple objects by

holding down the Shift key and selecting additional objects.
� Select the button to align the objects.

� Press to align selected controls on the leftmost edge. Enabled
when you select more than one control.

� Press to align selected controls on the rightmost edge.
Enabled when you select more than one control.

� Press to align selected controls on the topmost edge. Enabled
when you select more than one control.

� Press to align selected controls on the bottommost edge.
Enabled when you select more than one control.

� Press to align the selected controls’ centers on a vertical
axis. Enabled when you select more than one control.

� Press to align the selected controls’ centers on a horizontal
axis. Enabled when you select more than one control.

All selected controls will be aligned. If the results are not as expected,
access the Edit menu, Undo option.

Set Field Options
To set field options in Report Designer layout, double-click the field
object with the selection tool. The Report Expression form is
displayed.

See page 118 for the steps to access the Report Designer layout.
� Press Expression to add

an expression that will be
displayed in the report. See
page 128 for information
on Expression for Field
form.

� Press Format to display
the Format dialog so you
can specify formatting
options. See page 131 for
information on the Format
form.
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� Press Calculations… to display the Calculate Field form. When
checked, a calculation has been set for the chosen field.

� Press Print When… to display the Print When form and enter
criteria to determine when the field is displayed in the report. See
page 132 for information on the Print When form.

� Set field position:
� Select Float to maintain

the absolute position of
the field.

� Select Fix Relative to
top of band to maintain
the position of the field
relative to the top of
the band. This selection
allows stretching of the
field to accommodate
data that extends
beyond one line.

� Select Fix Relative to
bottom of band to maintain the position of the field relative to
the bottom of the band.

� Check Stretch with overflow to allow the fields to expand when
there is more information than fits in the box added to the Report
Designer layout.

� Type reference information in Comment. Comments are for report
design use only and do not affect the output.

Build an Expression for Field on Report Form
To build an expression, press on the Report Expression form. The
Expression for Field on Report: form is displayed.

Additional information on expressions and functions used in expressions is available in
the FH Online Help guide. Press F1 with the form displayed.
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Add Fields

You can type in the
expression in the Expression
field (not labeled) if you are
familiar with the functions
and fields names, or select
items to build an expression.

� Select function (if needed
in expression):
� String lists available

character functions.
� Math lists available

functions for
performing calculations in an expression.

� Logical lists available functions for adding conditions to an
expression.

� Date lists available functions for inserting dates in an
expression.

� Select the data source containing the field to add to the expression
in Show Fields From. When only one query is available for a report,
this field cannot be modified. The Fields list below Show fields from
is from the source selected here.

� If you have added functions, you should highlight the part of the
expression that will use the field before adding the field.

� Add the field listed in Fields to the expression by double-clicking on
the field listing, or highlighting the field listing and pressing Enter.

Your selections are inserted in the Expression field. Generally,
expressions are completed from the Fields section.

If you are done with the expression, see ‘Finish Expression for Field’ on page 131.

Add Objects

The Object section displays FH variables that can be inserted into the
report.
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� Change Show Property Values From
to display available FH
variables.  Double-click on
the variable to add to the
expression.

� Add String, Math, Logical,
Date functions as
previously described in the
Fields section.

Add Parameters

The Parameters section
displays filter variables that
can be inserted into the report. This section is only available when the
Filter section of the Query Designer form for the query includes
elements.

� Change Show Query
Parameter Values to
display available query
parameter values.
Double-click on the value
to add to the expression.

� Add String, Math, Logical,
Date functions as
previously described in the
Fields section.

If you are done with the expression,
see ‘Finish Expression for Field’ on
page 131.

Add Advanced Functions

Lists advanced FH functions. The advanced functions modify FH
values.

� You can browse the list of advanced functions by highlighting them
and reading the
description, or view details
about the function by
pressing Details…

If you are done with the expression,
see ‘Finish Expression for Field’ on
page 131.
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Finish Expression
� Press Verify to see whether the expression displayed in the

Expression field (not labeled on form) is valid.  The message
“Expression appears to be valid” appears in the status bar if the
expression is OK; if not, an error message is displayed.

� Press OK to save created expression and returns to the open Report
Expression form.

� Press Cancel to exit dialog without taking action.

Format Form
The Format field form allows you to specify how an expression is
formatted on the report form. Available format options vary depending
on the type of data included in the expression.

See “Set Field Options” on page 127 for the steps to access this form.

The Format field displays the format code selected via the check boxes.
You can type the format codes
manually or modify them using
this form. The appropriate data
type is automatically selected.
Change only if necessary.

Set Character Data Formatting
Options

With the Format form displayed
and Character selected:

� Check To upper case to convert all characters to uppercase.
� Check Ignore input mask to include non-format characters in the

format expression in the form or report.
� Check SET DATE format to display data as date using current

system date format.
� Check British date to display data as European (BRITISH) date.
� Check Left justify to print data flush left in the field.
� Check Right justify to print data flush right in the field.
� Check Center justify to center data in the field.
� Press OK to finish.
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Set Numeric Data Formatting Options

With the Format form displayed and
Numeric selected:

� Check Left Justify to start numeric
data for field at leftmost position in
the field.

� Check Blank if zero to blank field if
output is 0.

� Check (Negative)to place negative numbers in parentheses.
� Check SET DATE format to display data as date using current

system date format.
� Check British date to display data as European (BRITISH) date.
� Check CR if positive to append “CR” (credit) after number if number

is positive.
� Check DB if negative to append “DB” (debit) after number if number

is negative.
� Check Leading zeros to prints all leading zeros.
� Check Currency to display currency format.
� Check Scientific to display in scientific notation.
� Press OK to finish.

Set Date Data Formatting Options

With the Format form displayed and Date
selected:

� Check SET DATE format to display
data as date using current system date
format.

� Check British date to display data as
European (BRITISH) date.

� Press OK to finish.

Print When Form
The Print When form allows you to determine the conditions under
which items in your report or label are printed.

See “Set Field Options” on page 127 for the steps to access this form.
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� Select whether to print repeated values or not:
� Select Yes to have the

object print every time it’s
band is printed in your
report or label.

� Select No to have the
object print only in certain
situations, which you can
establish in other areas of
the dialog.

� Check In First Whole Band of
New Page/Column to print the
object in the first band of a
new page or column that isn't
an overflow from a previous page or column.

� Check When This Group Changes and choose a group from the form
to print the object when the chosen group changes. Only available if
groups have been added to the Report Designer layout.

� Check When Detail Overflows to New Page/Column to print the
object when the Detail band overflows to a new page or a new
column.

� Check Remove Line If Blank to not add space to the form for the line
if it is empty.

� Check Print Only When Expression is True… and type an expression
for determining when the object will be printed.

Report Picture Form
Double click on a picture or select to display the Report Picture
form. The Report Picture form allows you to include BMP pictures or
icon files.

� Select File to include a
picture in your report,
press to open the
Open dialog so you can
select the desired graphic
file, or you can type the
name and path of the file
in File…

� Select Field to select a field
from the results table
containing the attached
OLE object.
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� Select Clip Picture to retain the picture’s original dimensions. If the
picture is bigger than the frame created in the Report Layout
window, Clip Picture shows a section of the original picture in the
frame. The picture is anchored at the top and at the left of the
frame. The lower right portion of the picture that extends beyond
the frame is not visible in the report.

� Select Scale picture, retain shape to display the whole picture,
filling as much of the frame sized in the window as possible while
retaining the relative proportions of the picture.

� Check Scale picture, fill the frame to display the whole picture,
completely filling the frame that you size in the Report Designer
layout. The picture will take on the proportions of the frame. For
example, if you make the frame tall and narrow, the picture will be
distorted vertically and horizontally to fit the frame (that is, it will
take the shape of the frame).

� Select Float to position picture in absolute position regardless of
movement in the Report Designer layout.

� Select Fixed relative to top of band to position the picture relative to
the position you give it in the Report Designer layout and maintain
that position relative to the top of the band.

� Select Fixed relative to bottom of band to position the picture
relative to the position you give it in the Report Designer layout and
maintain that position relative to the bottom of the band.

� Add Comment for your reference and do not appear in the printed
report or label.

� Press Print When... to open the Print When form.
See page 132 for more information on the Print When... form.
� Press OK to save changes
� Press Cancel to exit without saving.
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Auto Generated Narratives

Auto-generated narratives build a comprehensive description of an incident based
on user-defined text and selected values from incident-related records. FH includes
some auto-generate narrative templates that are ready to use, or you can build your
own. Auto-generated narratives are available for NFIRS, EMS, and Dispatch/Remote
Station incident reports.
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Setting Up Auto-Narratives

Auto-Narratives are not available from the incident records by default.
Templates that grab information from the fire or EMS record and insert
them into the narrative are included. You can use a provided template
or create a new template from scratch.

You can generate an incident narrative that includes information from
other parts of the incident record using ‘Auto Generate’  narratives.
Auto Generate narratives are available for NFIRS, EMS, and
Dispatch/Remote incident records. The information included in the
narrative is based on the narrative generation template used. The
templates define the data elements from the record that will be used to
generate a narrative. FH supplies a template for each.

Enabling Auto Narratives
Auto-Narratives are not available from the incident records by default.

To Enable Auto-Narratives
� Select the Administration menu Administrative Options option.
� Select the Incident tab.
� Enable for each individual area desired:

� For NFIRS incident auto-narratives, select the NFIRS tab, then
check Provide the option to auto-generate the NFIRS incident
narrative.

� For EMS incident and EMS patient auto-narratives, select the
EMS/Search & Rescue tab, then check Provide the option to
auto-generate the EMS scene/patient narrative.

� For Dispatch/Remote Station Report auto-narratives, select the
Dispatch/Remote Station Report tab, then check the Provide the
option to auto-generate the Dispatch/Station narrative

� Press OK.

Creating New Templates
You can modify the auto-narrative templates by creating new template
or adding additional elements to the templates. A template can insert
information directly from fields, custom expressions, conditional
blocks, or from printed report forms.
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• Custom expressions insert a block of text or fields into the template
using the expression builder.

• Conditional blocks insert a block of text or fields into the template
that are displayed only if a given condition is true.

• Reports inserts the results of any printed report form into the
template at the position.

To Create a New Template
� Select the Administration menu Administrative Options option.
� Select the Incident tab NFIRS tab.
� Press Auto-Narrative Templates. The Auto-Generate Narrative

Templates form is displayed.
� Select the auto-narrative area in the Select Report Type field.
� Press New. You are prompted to copy an existing template. Press

Yes and select a template to copy if available, otherwise press No.
The Auto Narrative Properties form is displayed.

� Type a Template name.
� Add information as needed.
See ‘To Add Field Values to Auto-Narrative’ on page 137
� Press Save when finished.

To Add Field Value to Auto-Narrative
� Select the Administration menu Administrative Options option.
� Select the Incident tab NFIRS tab.
� Press Auto-Narrative Templates. The Auto-Generate Narrative

Templates form is displayed.
� Select the auto-narrative area in the Select Report Type field.
� Highlight the Auto-Generate Narrative Template to modify then

press Properties.
� Highlight the field to add in the Available Data Elements field.
� Press . All character type fields will be automatically ‘trimmed’

for leading and trailing spaces.
� Press Save.

To Add Custom Expression to Auto-Narrative
� Select the Administration menu Administrative Options option.
� Select the Incident tab NFIRS tab.
� Press Auto-Narrative Templates. The Auto-Generate Narrative

Templates form is displayed.
� Select the auto-narrative area in the Select Report Type field.
� Highlight the Auto-Generate Narrative Template to modify and

press Properties.
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� Press Advanced Expression. The Auto Narrative Setup form is
displayed to allow you to enter custom expressions into the
template.

� Add expression, then press OK.
See ‘To Set Field Expression’ on page 125 for more information on using expressions.
� Press Save.

To Add Conditional Block to Auto-Narrative
� Select the Administration menu Administrative Options option.
� Select the Incident tab NFIRS tab.
� Press Auto-Narrative Templates. The Auto-Generate Narrative

Templates form is displayed.
� Select the auto-narrative area in the Select Report Type field. Leave

as “NFIRS Incident Report” for this example.
� Highlight the Auto-Generate Narrative Template to modify and

press Properties. The Auto Narrative Properties form is displayed.
� Press Insert Conditional Block. The expression builder form

displayed.
� Create an expression that will evaluate as true or false. For

example, double click ‘Station’ then position your cursor after
Incidentrecord.Station and type =”1-0”. The expression:
Incidentrecord.Station=”1-0”
evaluates as true when the incident report Station value is equal to
“1-0”.

Create an expression that can be evaluated as true or false.

� Press OK. The conditional block with your expression is added to
the Narrative Template field:
#IF Incidentrecord.Station="1-0"
<place your text here..>
#ELSE
<place alternative text here..(remove if not used)>
#ENDIF
� Type the text or expression you wish to display if

Incidentrecord.Station="1-0" evaluates as true in place of
<place your text here…>.
• If you replace <place your text here..> with an

expression you must precede the expression with two left
arrows (<<) and end the expression with two right arrows
(>>). This automatically happens if you highlight <place
your text here..> then press Advanced Expression and
use the Auto Narrative Properties form to build the
expression.

• If you replace <place your text here..> with text, type
the text without the “<<” or “>>” characters.

� Type the text or expression you wish to display if
Incidentrecord.Station="1-0" evaluates as false in place
of <Place alternative text here..(remove if not
used)>.
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• If alternative text is not used when
Incidentrecord.Station="1-0" is false, the #ELSE
statement and the <place alternative text
here..(remove if not used)> lines  should be deleted
from the Narrative Template field.

• If you replace <place alternative text
here..(remove if not used)> with an expression you
must precede the expression with two left arrows (<<) and
end the expression with two right arrows (>>). This
automatically happens if you highlight <place
alternative text here..(remove if not used)>
then press Advanced Expression and use the Auto
Narrative Properties form to build the expression, or select
the field from Available Data Elements.

• If you replace <place alternative text
here..(remove if not used)> with text, type the text
without the “<<” or “>>” characters.

Conditional statements may NOT be nested. You can not
place one #IF statement inside another (the template
builder will allow you to do it, but it will not process as
expected).

� Press Save.

To Insert Report in Auto-Narrative
� Select the Administration menu Administrative Options option.
� Select the Incident tab NFIRS tab.
� Press Auto-Narrative Templates. The Auto-Generate Narrative

Templates form is displayed.
� Select the auto-narrative area in the Select Report Type field.
� Highlight the Auto-Generate Narrative Template to modify and

press Properties.
� Press Insert Report.
� The Select a Report form is displayed.
� Highlight the report to add, then press Select. The insert report

statement is added to the Narrative Template field. This block
should not be edited. Reports are left aligned in the template and
will show the output left aligned when the narrative is processed. If
a change needs to be made, delete the entire #InsertReport block
and re-insert the report.

� Press Save.

139Setting Up Auto-Narratives

No Nesting



Adding Signature Capture

You can add a form for collecting a signature to any area that an attachment can be
added to.
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About Signature Capture

Signature capture allows a signature to be digitally captured and
attached to any record that supports attachments. To add signature
capture to a specific record, you add a signature capture form that can
include values from records or expressions added to the form, and
graphic elements (lines, rectangles, or ellipses), graphic files (BMP,
WMF, or EMF), and captions.

To Add a Signature Capture Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the record group that the signature will be added from,

then press New. The query information is chosen based on the
group selected. Signature forms cannot be moved to alternate
groups once they are started.

� Type a Form Name and optionally add a detailed Description.
� Click the Data tab. By default, the values from the main record are

listed. Add additional queries to gather additional information if
necessary:
� Press Add.
� Highlight query to add, then press Select.
� Check Queries share parameter values to pass parameter from

the main query to other queries added for form.
� Click the Page Setup tab and define the form size.

� Page Size
� Orientation
� Margins
� Press Default Font to define the typeface, style, and size of text

added to the signature form.
� Optionally click Rules tab:

� Check Require this form to require the signature form.
� Type an expression that, when true, makes the signature form

required.
� Press OK. The signature setup layout form is displayed. You are

ready to setup the signature form layout.

About Signature Form Setup Layout
The signature form setup layout specifies how information is displayed
when the signature form is displayed. If you are familiar with the
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report designer layout form, you will be familiar with many of the
options included in the signature form setup layout, but there are

important differences.

All actions for the layout are performed using the menu or toolbars.

About Signature Form Design
The Design toolbar includes signature form

design options for setting form properties, saving and printing the
form, and adding or removing pages to the signature form.

To Edit Form Properties
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight signature form, then press Properties.
� Select the Form menu Properties option. The Signature Form

Setup form is displayed.
� Modify form properties as needed, then save and close.

To Add/Remove Page to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Add or remove a page:

143About Signature Capture



� To add a page, select the Form menu Add Page option. A page is
added.

� To remove a page (only available when multiple pages are
available) select the page number to delete in the Design toolbar,
then select the Form menu Remove Page option.

� Save and close signature form layout when finished.

To Change Layout Zoom Level
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the View menu Zoom option, then select the size of the

layout:
• “200%” displays the layout two times as large as actual size.
• “150%” displays the layout one and a half times as large as actual

size.
• “100%” displays the layout at actual size.
• “75%” displays the layout at three quarters actual size.
• “50%” displays the layout at half actual size.

� Save and close signature layout.

To Show/Hide Grid Lines
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the View menu Grid Lines option:

� If the Grid Line option is checkmarked, grid lines are currently
displayed and selecting the option hides the grid lines.

� If the Grid Line option is not checkmarked, grid lines are
currently not displayed and selecting the option shows the grid
lines.

� Save and close signature layout.

To Show/Hide Toolbars
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the View menu Toolbars option, then select the toolbar to

show or hide:
� If the toolbar checkmarked, the toolbar is currently displayed

and selecting the toolbar will hide the toolbar.
� If the toolbar is not checkmarked, it is not displayed and

selecting the toolbar will display the toolbar.
� Save and close signature layout.
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Adding Objects to the Signature Layout
You can add graphic objects and dynamic values to the signature form.
For example, you can add a system date or a value from an FH record.

Pointer is for selecting objects already added to the layout.

Text is for adding captions to the signature form. What you see is
what is included on the signature form.

Picture is for adding graphic files (BMP, WMF, or EMF) to the
signature form. Graphic files are displayed proportionately. What you
see is what is included on the signature form.

Line is for adding graphic lines to the signature form. What you see
is what is included on the signature form.

Rectangle is for adding graphic rectangles to the signature form.
What you see is what is included on the signature form.

Ellipse is for adding graphic ellipsis to the signature form. What you
see is what is included on the signature form.

Field is for adding values determined when the signature form is
accessed. The expression is displayed in the layout, but a specific value
is displayed when the signature form is accessed.

Table is for adding a specified number of columns and rows of
values determined when the signature form is accessed, especially for a
list of values. The expression is displayed in the layout, but a specific
value is displayed when the signature form is accessed.

To Add Text to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Properties.
� Select the Insert menu Text option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. The Text
form is displayed.

� Type the text to add to signature form.
� Optionally specify text attributes:

� Press Font and select a Font, Font Style, and Size, then press OK.
� Press Color, select a color, then press OK.
� Press OK.

� Press OK.

145About Signature Capture



To Add a Picture to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Picture option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. The Open
Picture form is displayed.

� Select a BMP, WMF, or EMF file to add to the signature form, then
press OK. The selected graphic is added to the signature form.

� Save and close signature layout.

To Add a Line to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Line option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button.
• If the area is wider than it is tall, a horizontal line is added.
• If the area is taller than it is wide, a vertical line is added.

� Save and close signature layout.

To Add a Rectangle to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Rectangle option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. A
rectangle is added.

� Save and close signature layout.

To Add an Ellipse to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Ellipse option.
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� Position cursor at top left corner of the area it will occupy, press
and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. An ellipse
is added to the signature layout form.

� Save and close signature layout.

To Add a Single Value to Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Field option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. The Field
form is displayed.

� Specify the Expression that will return a value.
� Optionally specify a Format to apply to the value returned by the

expression.
� Specify field attributes:

� Check Draw border around field to outline the field.
� Press Font and select a Font, Font Style, and Size, then press OK.
� Press Color, select a color, then press OK.

� Press OK.

To Add and Auto-Configure a Table of Values to a Signature Form
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Table option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. The
Table form is displayed.

� Select Row Data Source. All data sources added for the signature
form properties are available.

� Press . The Table Auto-Config form is displayed listing all
available data elements in the data source.

� Check each data element to add to the table. The data element name
is used in the column heading in bold-face, and the value(s) are
placed in the row(s). Uncheck Bold Column Headings to make
column heading text in non-boldfaced text.

� Press OK.
� Select Yes to prompt.
� Specify table format:
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� If Draw Border is checked, rows and columns are outlined by a
border.

� Press Font and select a Font, Font Style, and Size, then press OK.
� Press Border Color, select a color, then press OK.

� Press OK.
� Save and close signature layout.

To Add a Table of Values to Signature Form using Manual Method
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select the Insert menu Table option.
� Position cursor at top left corner of the area it will occupy, press

and hold the left mouse button, then drag the cursor to the lower
right corner of the area and release the left mouse button. The
Table form is displayed.

� Select Row Data Source. All data sources added for the signature
form properties are available.

� Define column:
� Click the column header (the first column is labeled ”Header1” by

default) then press . The Column Properties form is
displayed.

� Type in the text to display at the top of the column in Header
Text.

� Define Header Text attributes (if different than standard):
� Press B to bold-face column header text.
� Press I to italicize column header text.
� Press , select a color for column header text, then press

OK.
� Type or lookup an expression that will return values to the rows

in the column in Column Data Expression.
� Optionally specify a Format to apply to the value returned by the

expression.
� Define Column Data Expression attributes (if different than

standard):
� Press B to bold-face column header text.
� Press I to italicize column header text.
� Press , select a color for column header text, then press

OK.
� Select column Alignment.
� Specify the width, in pixels, allocated for the column. If the

value exceeds the specified width, the value will wrap to the
next line.

� Press OK. The Table form is displayed.
� Optionally add or remove additional columns:
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� Press below Columns and define the column (as described
above).

� Highlight a column and press to delete the selected column.
� Optionally add rows:

� Press below Rows.
� Specify table format:

� If Draw Border is checked, rows and columns are outlined by a
border.

� Press Font and select a Font, Font Style, and Size, then press OK.
� Press Border Color, select a color, then press OK.

� Press OK.
� Save and close signature layout.

About Signature Layout Format
After all objects have been added to the signature layout form, you can
modify the format of each of the objects individually. Format options
are accessed from the Format menu or the Format toolbar.

Align is for centering a selected object on the form vertically or
horizontally, or aligning multiple selected objects with one another.

Bring to Front is for bringing a selected object to the front. When
other objects overlap, the front object is on top and visible.

Send to Back is for sending a selected object to the back. When other
objects overlap, the back object in on the bottom and the overlapping
portion is not visible.

Font is for setting a font for a selected object.

Color is for setting a color for a selected object.

Pen is for setting a pen style for a selected object.

To Align Object(s) in the Signature Layout
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select a single object, position mouse pointer over object, then
click left mouse button.
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� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Align option, then select to center
horizontally or center vertically.
• Center Horizontally places the selected object(s) in the horizontal

center of the form. The object(s) will not be moved up or down.
• Center Vertically places the selected object(s) in the vertical

center of the form. The object(s) will not be moved left or right.
� Save and close layout.

To Align Objects to One Another
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Align option, then select to center
horizontally or center vertically.
• Align Left Edges places the left edges of selected objects in the

same horizontal position. The objects will not be moved up or
down.

• Align Right Edges places the right edges of selected objects in the
same vertical position. The objects will not be moved up or
down.

• Align Top Edges places the top edges of selected objects in the
same horizontal position. The objects will not be moved left or
right.
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• Align Bottom Edges places the bottom edges of selected objects
in the same vertical position. The objects will not be moved left
or right.

� Save and close layout.

To Bring an Object(s) to the Front
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select a single object, position mouse pointer over object, then
click left mouse button.

� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Bring to Front option.
� Save and close layout.

To Send an Object(s) to the Back
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select a single object, position mouse pointer over object, then
click left mouse button.

� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Send to Back option.
� Save and close layout.
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To Change Object(s) Font
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select a single object, position mouse pointer over object, then
click left mouse button.

� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Font option.
� Select Font, Font Style, and Font Size, then press OK.
� Save and close layout.

To Change Object(s) Color
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select a single object, position mouse pointer over object, then
click left mouse button.

� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Color option.
� Select a color then press OK.
� Save and close layout.
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To Change Object(s) Pen
� Select the Administration menu, Signature Form Setup option.

The Signature Form Setup form is displayed.
� Highlight the signature form, then press Layout.
� Select object(s) to align:

� To select a single object, position mouse pointer over object, then
click left mouse button.

� To select multiple objects in an area, position the mouse pointer
in the upper left corner of the area where the objects are
displayed, click and hold the left mouse button, then drag the
cursor to the lower right corner of the area and release the left
mouse button. All area objects are selected.

� To select multiple objects that are in different areas, press and
hold the Shift key, position mouse pointer over next object and
click the left mouse button, then position mouse pointer over
next object and click left mouse button, until all desired objects
are selected. You can release the Shift key after all objects are
selected.

� Select the Format menu Pen option.
� Select pen size or style.
� Save and close layout.

Using Signature Capture
Once signature forms have been set up, they are ready to be used to
capture signatures. Typically departments will use signature capture
on a tablet PC.

To Capture a Signature
� Access the data entry form Other section.
� Press Attachments & Signatures.
� Click the Signatures tab.

Signatures added from FH Onsite Inspections from a PPC
device are attached to inspection records as attached files.

� Press Add. The Select Signature Form is displayed.
� Highlight the Form Name, then press OK.
� Capture signature.
� Select the Form menu, Save and Close option when finished.
� Press OK to prompt.
� Press Close.
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Signature Forms and Printed Reports
Signature forms can be included on printed reports.

To Include Signature on Report

1) The signature form is captured as an ole object that is kept in a
memo field.  Depending on the location where the signature is saved, it
may be linked to the parent table in different ways.  It is up to the user
to create a query that gathers the signature memo (sign_form) from it's
attachment file (att_sign).  The reality is that in order to make the
process flexible enough, the user would have to know the parent table,
keys, and which signature is desired - so making them include it in the
query was deemed feasible at this point.

2) The signature is stored in a proprietary format that cannot simply be
placed on a printed form.  Thus we need to convert the signature to a
bitmap image in order for it to be printed.  The process of creating a
bitmap image is a bit complicated, and thus converting it into a General
field would not be feasible without requiring some external knowledge
- Thus we create the bitmap and return a temporary path to the bitmap
so that the user can include the bitmap in their report.  We could create
a general field, but it would have to be done similar to another bitmap
to general function that requires that another table be created, and
adds another level of unneeded complexity.

3) By using SigtoBitmap in a query, the user is given the temporary link
to the bitmap.  This link is to be included as the source (file) to an ole
control on the form, it will print the form as a bitmap.

4) the temporary bitmap will be deleted after the report session is
closed.

Process -

1) Create query with the signature attachment memo field included

2) Use the predefined function in the query definition form to convert
the memo to a temporary bitmap (use the "Custom Field Expression" to
build the results using the SigToBmp function against the sign_form
memo value)

3) Add an ole object to your report (generally this will be the only item
on the report since the actual signature form would be the entire size
of the report form)

4) set the FILE property for the ole object to be the field name
containing the results from step 2.  Be certain to use the cursor alias
with the field name if there is more than one cursor used for the report.
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Creating and Modifying Graphs

Graphs can be modified or created from scratch. All graphs include graph design
properties and gathered data to display in the graph. Graphs included with FH can
be directly modified, but we recommend that you modify a copy of the graph so
future software updates can update graphs without overwriting your changes.
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Graph Creation Overview

To start a new graph:

1. Click on the Graphs menu, and select the area you wish to add a
new graph to. The Graphs form is displayed with the selected graph
category open.

2. Select the graph category
to add a graph to. If
necessary, press next to
the graph category to
display specific graph
categories.

3. Press New. You are
prompted to copy an
existing graph or create a
new graph.

If you want to copy an
existing graph, see "Copy An Existing Graph", below. If you want to
create a new graph, skip to "Create A New Graph", page 156.

Copy an Existing Graph
Make a copy of an existing graph and make changes to the copy. With
the prompt displayed:

� Select Yes to the prompt. The Graphs form is displayed.
� Locate the graph you wish to make a copy of, then press Select. The

Graph Designer form is displayed with the copied graph
information.

� Position cursor over Save button, and right-mouse click.
� Select Save & Close.
� Modify the Graph options as needed.

Create a New Graph
Create a new graph from scratch. With the prompt displayed, complete
the following steps.

The steps leading up to this start in "Graph Creation Overview", page 156.
� Select No to the prompt. The Graph Designer form is displayed.
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� Type a name for the graph in Graph Name.
� Graph Category contains the graph category highlighted when the

new graph was initiated. You can modify the selected graph
category if necessary.

� Type a descriptive phrase about the graph in Comments. The
message will display in the Graphs form status bar, and could help
users identify the purpose of the graph without having to run it.

� Check Include this graph on the Graphs Shortcuts menu to add the
graph to the Graphs menu Graph Shortcuts submenu. include the
most frequently accessed graphs for your department in this area.

� Check Hide this graph to prevent the graph from being included in
the Graphs form listing (unless Show Hidden Graphs is checked).

Add Query to Graph

You're ready to add a query. The query gathers the data for display on
the graph form.

� Press Add. The Queries form is displayed.
� Select whether to copy an existing query or to create a new one:

� To copy an existing query select Yes and find a query to copy
or press Ctrl+F to search for the query using a keyword.

� To create a blank query select No. The Query Designer form
is displayed.

� Define or edit (if a copy was created) the query.
Creating and defining queries is described in Chapter 7.

Be sure to include all of the information that you will include in the
graph. When you're finished, save and close the new query. The
Queries form is displayed with your query highlighted.

� Press Select. The Graph Query prompt is displayed.
� Change Query Alias Name only if you have a specific reason for

doing so.
� Check Don’t requery if alias name is already in use to not run

query if the alias name assigned to the query is already in use.
� Press OK. The query is added to the query area of the Graph

Designer form.

Set Graph Options

You have defined the graph design properties, added a query to gather
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the data for the graph, and the Graph Designer form is still displayed.
Press the Graph Options tab to display the Graph Options section.

You want to
make your
graph easy
to
understand.
If you are
looking for a
directional
trend,
consider
one of the
line graph
types or if you want to display percentages choose the pie
graph type.

� Select a Graph Type:

� Select Bar to display the graph in side by side columns of
information. Information is color coded for each type of
information displayed.

� Select Stacked to display the information in columns placed on
top of each other. Information is color coded for each type of
information displayed.

� Select Line to display information in points and the line connects
them. This shows upward and downward trends.

� Select Curved Line for a display like Line except the line is
curved instead of straight.

� Select Area to display a line of the plotted points then shading in
the area below the line.

� Select Points to display the information at plotted points without
connections between the points.

� Select Pie to display information in percentages.
� Check View  3D to display the graph in three dimensions.
� Check Show legend to display the description of the color-coded

information. This is recommended if the graph is comparing values
to help the reader distinguish each value.

� Check View vertically to reverse the X and Y axis.
� Check Graph background color to choose the background color for

your graph.

To make a valid graph you need to choose at least one numeric field
and one character field. The character field is displayed on the Y axis
(or as the different slices on a Pie graph). The numeric field values are
plotted on the X axis.
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� Add fields from Available Graph Fields by highlighting a field and
pushing , or by double clicking on the field. The field is added to
Selected Graph Fields.

� Save all changes made to the Graph Options section. Press the View
Graph button to preview your graph.
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Sample Graph

The steps to create a graph that displays the number of incidents of
each alarm type are listed below.

1. From the Graphs menu, select the Incident Graphs option. The
Graphs form is displayed.

2. Press New. Select No to prompt “Would you like to start by making
a copy?” The Graph Designer form is displayed.

3. Type “Incidents by Alarm
Type” in Graph Name.

4. Type “This graph lists the
number of incidents of
each alarm type.” in
Comments.

5. Check Include this report
on the Graph Shortcuts.

6. Press Add. The Queries
form is displayed.

7. Press New. Select “No” to prompt “Would you like to start by
making a copy?” The Query Designer form is displayed.

8. Type “Incidents by Alarm Type” in Query Name. Select the Tables
tab.

9. Select Incident, Inc_main table. Select the Fields tab.

10. Highlight Inc_id, then press Count, then select “Count Distinct
Values” when prompted. A count field is added.

11. Highlight Alm_type, then
press . Select the Order
By tab.

12. Highlight
Inc_main.Alm_type then
press . Select the Group
By tab.

13. Highlight Alm_type then
press .

14. Press Save, then Close.
The Queries form is displayed. Press Select. The Graph Designer
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form with your new query is displayed. Select the Graph Options
tab.

15. Highlight each field and press .

16. Press Save.

17. Press View Graph. The Graph form containing the graph is
displayed. If you wish to experiment with different graph types,
close the Graph form,
change the Graph Type in
the Graph Designer form
then press View Graph to
see results. Save and close
when ready.
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User-Defined Fields To State

User-defined fields can be added and included in incident transaction files.

Do not do this unless you have to. Your state will typically provide this
information as an installable option. It is only included here for your
reference. The method below is not recommended for sharing data
between departments. NFIRS and EMS transaction files are standard text
files that include required information that the state uses for analyzing
incidents. Each required element of an incident is included in the
transaction file in a standard format. It is beyond the scope of this manual
to detail the structure of the NFIRS or EMS transaction file. More is
available from the NFIRS design document. User defined fields can be
included in NFIRS or EMS transaction files.

Adding user-defined fields is described in Chapter 6 of this manual.

Appendix A
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Available User-Defined Field Areas

Listed below are the areas where user-defined fields can be added for
inclusion in the transaction file, and the corresponding form from
which user-defined fields will be accessed

Available Area Form Name
NFIRS Incident Reporting

NFIRS Incident Report User fields NFIRS Incident Report form

Incident Involvement User fields Involvement form

Civilian Casualty User fields Civilian Fire Casualty Report form

Fire Service Casualty User fields Fire Service Casualty Report form

Investigation Report User fields Investigation Report form

Investigation- Suspect/Involvement User fields
Investigative Leads/Involvement Report

form

EMS/Search & Rescue Incident Reporting

EMS/Search & Rescue Incident User fields EMS/Search & Rescue Report form

EMS/Search & Rescue Patient/Victim User
fields

Patient/Victim Information form

User-defined fields can be initially setup directly from the form where
they will be entered. To set up user-defined fields for the first time,
access the Other section of the form where the user-defined field will
be added, press User Fields... then answer Yes to the prompt.

The standard method for setting up user-defined fields is detailed on page 62.
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Add User Fields to NFIRS Export

If your state requires specific fields in addition to the basic NFIRS 5.0
specification, you will need to add these fields. Some states use FH for
data collection and will provide these user-defined fields as an FH
component, so be sure to contact your state reporting agency before
adding user-defined fields for inclusion in incident transaction files.

See the help file “Copy and Install Components” topic for information on installing
components like user-fields and codes that have been set up.

When you add user-defined fields for incident transaction files, each
field is associated with a specific user-defined record type and each
field associated with the record type is assigned a sequence number.

Available record types:

• NFIRS 5.0:
7000 - 7999 types are reserved for local use
8000 - 8999 types are reserved for state use

• EMS:
17000 - 17999 types are reserved for local use
18000 - 18999 types are reserved for state use

• EMS Patient:
19000 - 19499 types are reserved for local use
19500 - 19999 types are reserved for state use
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Below is a fictitious example. Your state requires incident transaction
files to include information about water source and total water volume
used to extinguish fires. They provide the following specification for
this information:

Record Type 8000:

Field Name Width Format

Water Source 1 15 Character

Water Source 2 15 Character

Water Source 3 15 Character

Total Water Volume 9 Numeric, 2 decimals

The “8000” records are submitted as two fields, one field that includes
as many as three water sources, and the second field that includes the
total volume of water in gallons.

� From the Administration menu select the User-Defined Fields…
option.

� Highlight NFIRS Incident Reporting, NFIRS Incident Report User
Fields then press Setup. The Incident User Fields form is
displayed.

Add Water Source Fields
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type “Water Source 1” in

Field Name. Caption is
automatically filled with
the value entered in Field
Name. Edit this value if
you want the label
displayed next to the field
to be different than the
field name (the field
caption will not affect the
transaction file).

� Select “Character” for Data
Type, then type “8” for
Length.

To ensure that consistent values are entered for water source, make
the water source fields lookup driven.

� Check Lookup… The Category field becomes required.
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Add a New Lookup Category
� Type “Wtr Src” in Category.
� Access the User-Defined Field Properties Other... section.
� Check Export as NFIRS 5.0 user field transaction.

� Select record type “8000”.
� Check Field is part of a

multiple pick.
� Type “1” in Export

Sequence.

The value in Export Sequence
for all fields that are grouped
together must be the same.

� Press OK, then Yes to the prompt to create new lookup category.
The Code Set form is displayed.

� Press OK. You can add valid codes to your new lookup category now
by pressing next to the
new lookup-driven
user-defined field.

Repeat the steps listed under
“Add Field” for Water Source 2
and Water Source 3. The only difference will be the Field Name. The
water source fields will share the “Wtr Src” lookup category, so you
will not be prompted to create a new lookup category. Be sure to assign
the correct value for Record Type, check Field is part of a multiple pick
and use “1” for Export Sequence.

Add Total Water Volume Field
� Press then position your cursor in the area you wish to add the

field to.
� Press your left mouse button. The User-Defined Field Properties

form is displayed.
� Type “Total Water Volume” in Field Name. Caption is automatically

filled with the value
entered in Field Name.
Edit this value if you want
the label displayed next to
the field to be different
than the field name (the
field caption will not affect
the transaction file).

� Change Data Type to
“Numeric”.

� Type “9” in Length.
� Type “2” in Decimals.
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� Access the User-Defined Field Properties Other... section.
� Select record type “8000”.
� Type “2” in Export

Sequence.
� Press OK.
� Press Save. All field

additions and
modifications are listed in
the Confirm Update form.

� Press OK. The
User-Defined Fields Setup form is displayed.

� Press Close.

You are ready to start using your user-defined fields. When incidents
are entered, the user-defined fields can be completed and included in
the export transaction file (be sure that Export state user field
transactions is checked in the export wizard).
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